
User Manual 

The product warranty is attached to the user manual. 

Read the User Manual before operating the product, 
and keep the manual at a convenient place near the product. 
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Be sure to oBserve the following instructions when using the device.

Safety Instructions

warning : failure to observe the instructions may lead to death or serious injury.

  Directly plug the power cord in the receptacle on the wall. Do not use extension cord.

  If the power cable or plug is worn or damaged, pull out the power plug.

  In order to prevent electric shock or exposure to laser radiation (in case of a laser device),

 do not remove the cover or screw which is not stated in the user manual.

  Turn off power and pull out the power plug in the following situations;      

 - If something is spilled on the device

   - When considering the service or repair request on the device

   - When the device cover is damaged

  In case of a device using toner, do not burn the spilled toner or the waste toner.

 If a toner particle is exposed to the screen, it may be ignited.

  In case of disposal, contact our company’s seller use the proper collection place.

  In case of not using the product for a long time or when leaving the office after business

 hours, turn off the power. Otherwise, it may cause an abrupt fire accident.

  Protect the device from a humid or wet condition including rain, snow, and so on.

  Pull the power cord off from the receptacle on the wall before moving the device. 

 Be careful not to damage the power cord while the device is being moved.

  Be sure not to pull the cable when pulling the power cord off from the wall receptacle. 

 Be sure to pull out with the plug.

  Be sure not to have a clip, a staple, or another small metal object fell inside the device.

  Be careful of a safety accident when servicing the inside of the device including the 

 removal of paper jam, cleaning of the inside of the device, and so on.

  In case of the device using toner, keep the toner and the toner container in the place

 where cannot be reached by a child.

  Do not dispose of the device or consumables in the place treating household waste. 

 In case of disposal, contact our company’s seller use the proper collection place.

  The inside of the device may be very hot. Do not touch the part with the “Careful! Very

 Hot!” label attached or the spot around the part. Otherwise, it may cause burn.

  Our company’s product conforms to the quality standards and performance. 

 It is recommended to use only the genuine parts possibly purchased from an authorized 

 distributor.

caution: failure to observe the instructions may cause serious and slight injuries or
    property damages. 



                  

Really thank you for purchasing our product. 

In this user manual, it contains how to use the device correctly and how to repair the 

devivice simply are described in details to maintain the product in optimal state at all 

times andcontribute to the rationalization and effciency of the office work of your 

company.

Carefully read the user manual before using the device and keep oit close at hand.

In order to use the device safely and correctly, be sure to read the caution on the 

safe use before using it.

Before Use

Prohibition and Limitation on Duplication

1. The details of the user manual can be changed without a prior notice. 

 Our company is not responsible for the direct and/or indirect loss or damages 

 caused by results of handling or operating the product in any case and for the 

 results occurring from user’s negligence.

2. The act of duplicating or printing a bill, revenue stamp, bond, share certificate, 

 bank draft, check, passport, and driver’s license distributed at home and abroad 

 is prohibited according to a law. 

3. The copyrighted literary works such as books, cores, figures, maps, drawings, 

 and photos can be duplicated and used for personal use or household use and 

 within the same scope. In other cases, it is prohibited according to a law.

4. The above details present only a part of the applicable laws and regulations. 

 The details of the law are not stated as they are. Our company is not responsible 

 for correctness and completeness. Receive a legal consulting service to check if 

 the duplication or printing of an object is legal. 
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Before Use

1. Introduction

The user manual provides detailed explanation and precautions on the operation and usage of the 

device. 

Read the manual carefully before operating the device for user safety and convenience.

Keep the user manual nearby to find it promptly. 

 Important

   - The descriptions of the user manual can be modified without a prior notice. 

    The company is not responsible for any indirect, special, supplementary, and resultant   

    damages caused by the device handling and operation.

    Duplication or printing to produce an illegal duplicate is prohibited. 

    Generally, the duplication or printing of bills, revenue stamps, bonds, share certificates,   

    bank drafts, checks, passports, driver’s licenses, and so on is prohibited in the local law.

    The above list is just an example. The details of the above list are not all. 

    The company is not responsible for whether the above list is the total or correct list. 

    Receive the local legal counseling if it is questionable about whether the duplication or   

    printing of an object is legal. 

 Note

   - The features of the user manual may be a bit different from those of the actual device.

    Some options may not be usable in a certain country. 

    Inquire of the local sales representative of the user about the above matter.

    A unit can be optional depending on the user’s country.

    Inquire of the authorized local service depot about the matter. 

  - A special type may not be used in a certain country.

    Inquire of the local sales representative for further details.

  - The two types of size display methods are used in the user manual.

    The meter version is applied to the device. 
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2. How to Read this User Manual

  Symbols 

The user manual uses following symbols:

 Warning

 Important safety instruction is introduced.

 Not obeying the instruction may cause a serious injury or death.

 Be sure to read it. Refer to the caution on the safe use of the device.

 Caution

 Important safety instruction is introduced.

 Not obeying the instruction may cause a minor injury or damage on property Equipment.

 Be sure to read it. Refer to the caution on the safe use of the device.

 Important

  The cautions on the use of the device, the wrong feed of paper, the damage of the original copy,  

 and the damage of data are explained. Be sure to read it.

 The symbol represents the prior information needed before operation.

 Note

 This symbol represents the description on the function of the device and the action on user 

 errors.

 Reference

  The symbol is located in the end of the paragraph, representing the place where the relevant 

 details are.

 [      ]

 It represents the message or menu displayed in the device LCD display window.

 【     】

 It represents the name of each function key displayed in the device control panel and the 

 `display window.
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3. Safety Information 

Plug the power cord to the wall outlet which is near the device, which is easily accessible and 

properly grounded. Do not use or store the device in the wet or humid environment. 

 Caution  Danger of Injury

    - The product uses laser. The control, adjustment, or execution of the procedure not stated in  

    the document may cause exposure to harmful electromagnetic wave.

    The product uses a printing media heating method so that gas may be emitted from paper  

    due to heating. In order to prevent the emission of harmful gas, the section addressing the  

    details on the selection of printing media in the operating instructions should be 

    understood.

 Caution   High Temperature on the Surface

    - The inside of the device may be hot. Let the surface cooled down to prevent the damage   

    caused by a hot part. Touch it later on.

 Caution   Damage of Injury

    - Follow below instructions to prevent personal injuries or device damage before moving   

    the  device. Switch off the device and then unplug the power cord. Remove all cords and   

    cables  from the device before moving it. Do not lift the optional feeder and device at the   

    same time. Lift the device first, and then use both side handles to lift the feeder. Use only   

    the power cord provided with this device or the one approved by the manufacturer.

 Caution   Danger of Electric Shock

    - In case of accessing the system board or installing a memory option device after  installing  

    the device, do the work after turning off the device and unplugging the power cord. 

    If another device is connected to the printer, turn off another device and separate the   

    cable connected to the printer.

 Caution   Danger of Electric Shock

  - The design test of the product was passed and approved by using the component meeting  

    the strict international safety standards. The safety function of a part may not be clear. 

    The corresponding manufacturer is not responsible for the usage of another replacement   

    part.
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 Caution   Danger of Injury

    - Do not twist or bend the power cord, step on it, or put a heavy object on it. Be careful not  

    to have the power cord stripped off or overloaded. Do not have the power cord get jammed  

    into the gap of an object such as furniture or a wall. The misuse of the power cord may   

    cause fire or electric shock. 

    Check the power cord regularly. Unplug the power cord from the receptacle for inspection.

    Inquire of the service specialist about the service or repair problem not stated in the user   

    manual

      Caution  Danger of Electric Shock

      - When cleaning the outside of the Devices, disconnect the power cord from the receptacle    

	 	 		 and all the cables connected to the prevent electric shock.

 Caution   Danger Laser Safety

    - The Center of Devices and Radiological Health (CDRH) prohibits the repair of laser-based 

              optical units in the field. The optical housing unit can only be repaired in a factory or

              at a location with the requisite equipment. The laser subsystem is replaceable in the field

              by a qualified Customer Engineer. The laser chassis is not repairable in the field. 

              Customer engineers are therefore directed to return all chassis and laser subsystems to 

              the factory or service depot when replacement of the optical subsystem is required.
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4. Notice

Noise	Level

 Followings are measured according to ISO 7779 and determined to meet ISO 9296. Some   

 modes may not be available in your device. 

1 m average sound pressure  (dBA)

Printing 49dBA

Copying 53dBA

Standing by < 30dBA 

Temperature

Operating Temperature 15.6 C~32.2 C

Shipping and Storage Temperature -40.0 C~60.0 C

Disposal	of	the	Device

 Do not dispose the device and Consumables in the same as normal garbage. For disposal   

 and recycling, contact your dealer.

Laser	Notice

 This machine is certified in the U.S. to conform to the requirements of DHHS21 CFR Subchapter

      J for Class 1 laser products, and elsewhere is certified as a Class 1 laser product conforming 

      to the requirements of IEC 60825-1. Class 1 laser products are not considered to be hazardous. 

      This machine uses two AIGaAs laser diodes with a wave length of 770~800 nm and an output of

      15mW. The laser system and machine are designed so there is never any human access to laser 

      radiation above a Class 1 level during normal operation, user maintenance or prescribed service

      condition.

Class 1 Laser  Product
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Power	Consumption	

Power Consumption of the Product

 The below table shows power consumption. Some modes may not be available in your device.

Mode Description
Power Consumption 

(W)  

Printing The device is printing paper with electric input data. < 540W 

Stand-by The device is standing by. < 85W 

Power Saving The device is in the power-saving mode. < 6W 

Off The device is off with its power plug plugged. < 0.05W 

 Above power consumption is the hourly average value. 

 Instant power consumption can be much higher than the average value.

Energy Saver Mode

 The device is designed for the energy saver mode. 

 The energy saver mode is the EPA sleep mode. In the energy saver mode that the device enters  

 while it is not used for a certain period of time, it reduces power consumption. 

 By default, the time to activate the energy saver mode is factory-set to 3 minutes. 

 In the configuration mode, you can change the Energy Saver Mode time to 1 ~ 240 minutes. 

 If the energy saver mode time is low, you can save energy but the device responses slowly.

 If the energy saver mode time is high, the device responses fast but more energy is used.

Deactivated Mode 

 Even in the deactivated mode, the device consumes power. To stop power consumption fully,   

 unplug the power cord

Total Energy Usage  

 It would be useful to calculate the Total energy usage of the device. 

 Since the electricity bill is charge by watt, to calculate energy use, you have to multiply time   

 spent in each mode with power consumption. 

 Total energy usage is the sum of energy use in each mode.

Wireless LAN Specification

 This device may be affected by electromagnetic interference. So, it cannot be used for life 

 saving service.
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Condensation

 A dramatic change in ambient temperatures can create small water drops in and out of the 

 device. Remove water drops on the outer surface. To remove water drops inside the device,   

 open the platen or ADF and wait until they disappear.

Note

  -  This equipment has been tested and found to comply with the limits for a Class A digital device, 

pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 

 protection against harmful interference when the equipment is operated in a commercial 

 environment. This equipment generates, uses, and can radiate radio frequency energy and, 

 if not installed and used in accordance with the instruction manual, may cause harmful 

 interference to radio communications. Operation of this equipment in a residential area is likely     

 to cause harmful interference in which case the user will be required to correct the interference  

 at his own expense.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 

conditions: 

(1) this device may not cause harmful interference, and 

(2) this device must accept any interference received, including interference that may cause

 undesired operation. 

Caution

		-		Changes	or	modifications	not	expressly	by	the	manufacturer	could	void	the	user's	authority	to			

						operate	the	equipment.

Exposure	to	radio	frequency	radiation

 The following notice is applicable if your printer has a wireless network card installed.

 The radiated output power of this device is far below the FCC radio frequency exposure limits. 

 Aminimum separation of 20 cm (8 inches) must be maintained between the antenna and any   

 persons for this device to satisfy the RF exposure requirements of the FCC.

This	Class	[B]	digital	apparatus	complies	with	Canadian	ICES-003.

	 Cet appareil num rique de la classe [A] est conforme  la norme NMB-003 du Canada.
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5. Precautions 

Follow below instructions along with Safety Information provided when you purchase the device.

  Install the device 

 Warning

    - Install the device where good ventilation is provided. 

    Ozone is generated while the device is operating. Though the ozone amount is not 

    dangerous, if the device is used for a long time or a large number of sheets are printed,   

    sufficient ventilation is needed. 

 Caution   

  - Keep the device’s vents a least 10 cm away from walls and other equipment. 

  - Secure sufficient space around the device for easy ventilation and operation. 

  - Use the device with temperatures of 10 C ~ 32 C and relative humidity of 20% ~ 80%.

  - Do not install or use the device outdoor. 

  - To scan the DLT paper, keep the device’s back 15 cm away from surroundings.

M402/M403	Series

            

55
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  Move the device  

 Warning

  - Before moving the device, be sure to unplug the power cord. Use at least two people to   

    move the device.

  - Remove the toner cartridge when moving the device.

  - Hold the bottom of the device when moving the device. 

    Bend your needs enough to protect your spine when lifting the device.
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6. Handling Consumables 

  Caution  

  - Do not burn toner or drum cartridges. Remaining toners can cause a large fire or burns.

 Warning

  -  Do not use force to open toners or other consumables. Do not inhale toner powder and 

keep it away from your skin. Keep toners away from children. If your skin contacts toners, 

remove them with flowing water and soap. If you have any skin problem, contact your 

doctor. 

 Important  

        -    Do not touch the green surface of the drum cartage or expose it to the direct sunray. This   

 may drop printing quality.

  - Do not keep drum cartridges or toner cartridges upside down or store them in the slanted  

   place. This may drop printing quality.

  - Do not dismantle drum cartridges or toner cartridges.

  - Keep drum cartridges and toner cartridges away from physical impact or vibration.

  - Do not unpack drum cartridges and toner cartridges until you are ready to use them. 



11

Before Use

7. Precautions in Using the Device 

Plug the power cord to the wall outlet which is near the device, is easily accessible and is properly 

grounded. Do not use or store the device in the wet or humid environment. 

 Warning

        - The fusing unit and its surroundings are very hot while the device is operating. 

   Make sure not to touch the fusing unit while removing paper jams or checking inside of the  

   device. This may cause burns.

  - Prevent toner power from entering your eyes or mouth while removing paper jams or   

   replacing toner cartridges. If toner enters your eyes or mouth, wash them away with clean  

   water and consult your doctor.

  - Make sure your hands or clothes are tainted with toner. Wash toner away with cold water if  

   your hands or clothes are tainted with toner. If hot water is used, stains may remain.

  - Use the device only for functions described in this manual. 
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8. Ventilation

 Warning

         - Use the device in a place with good ventilation. If the device is used in a place with bad   

   ventilation, this may be harmful for your health. Ventilate regularly. 

  - Do not block vents. Inappropriate cooling may lead to high temperatures inside the device,  

   resulting in malfunction. 

   - In general, the new device produces a little amount of gas. So, provide good ventilation   

    during the first use of the device. If the device is operating for a long time, it is     

    recommended you should be away from the place where the device is installed.   
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9. Disposal of Batteries 

 Warning

  - Ni-MH batteries are installed for the backup memory. Dispose batteries in an environment-

    friendly way according to manufacturer’s instruction. To replace batteries, consult   

    the qualified service technician.
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1. Specifications

Model M402 M403

Printing Rate 34ppm 38ppm 

Memory 256MB 

Printing Resolution Enhanced Resolution 1200

Interface 1 USB, 1 Ethernet, Wi-Fi(Option)

Emulation PCL5e/6, PS3, SDHAPL

Tray 250 sheets

Multipurpose Tray 50 sheets

Cartridge M402

: 1500 sheets

M403

: 1500 sheets

2-sided Printing Automatic 2-sided Printing

Scan Type Color CIS

Scan Resolution 600X600dpi

ADF Capacity 35 sheets 20lb (Standard Paper)

Scan Rate 25spm

Dimension (WxDxH) 16.3”X14.8”X13.9”

Weight 31.4 lb  (IC included)
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12. Major Functions 

 Copy

Basic Copy 

Various originals can be copied into paper with a desirable size. 

For more information, see 「Basic Copy」 (P. 2-6).

Multiple Sheet Copy

The scanned original can be copied up to 99 sheets. For more information, see 「Basic Copy」 

(P. 2-6). 

Combined Copy

Two or four pages of the original can be copied into the one sheet. For more information, see 

「Combined Copy」 (P. 2-10).

ID/Card/OHP Copy 

Both sides of the ID or business card can be copied into the one sheet. 

Originals can be copied into OHP. 

For more information, see 「ID/Card/OHP Copy」 (P. 2-11).

 Scanner

Scanning from the PC

With the TWAIN compatible program, you can scan from your PC. 

The scanned file is transferred to the application program and can be edited and stored with the 

application program. 

For more information, see 「Scan with the PC」 (P. 3-4).

Scan from the Device Body

By using the control panel in the device body, the scanned image can on the USB memory, e-

mailed or saved on the FTP server. Files are stored in JPG, PDF, or TIFF. 

For more information, see 「Scan with the USB Memory」 (P. 3-9).

 Printer

Printing from the PC

Install the driver on your PC and use the MFP as your printer. 

For more information, see 「Update of Options Available for the MFP Driver」 (P. 3-2).
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Printing from the USB Memory 

Print image files stored on the USB memory by connecting the USB memory directly to the device. 

Compatible files are JPG and BMP files. 

For more information, see 「Print with the USB Memory」 (P. 3-36).

  Note

        -  Some image files may not be supported depending on their compression method. 

 Fax

Basic Fax 

Enter the receiver’s number and place the document on the exposure glass or ADF to fax the docu-

ment to the receiver. For more information, see 「Basic Fax」 (P. 3-37). 

Advanced Fax  

Use advanced fax functions to send documents more conveniently. 

For more information, see  「Advanced Fax」 (P. 3-40).
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13. Device Overview
 The Name and Function of Each Part (Front) 

No. Name Description

1 Tray 1 250 sheets of document (Based on 75g/m (20lb) paper)

2 Tray 2 Optional tray for 250 sheets of document 

(Based on 75g/m (20lb) paper): You should purchase it 

separately if it is not installed by default.

3 Multipurpose Tray Tray for standard paper, label paper or envelops

4 Front Cover Open the cover to install the cartridge or check the device.

5 Output Bin Bin for output paper.

6 Front Cover Opening 

Lever

Use this lever to open the front cover.

7 Output Tray Tray for copied or printed paper.

8 Handle Use this handle to move the device or install the optional 

feeder.

9 ADF (Automatic 

Document Feeder) Cover

Open this cover to remove paper jams.

10 ADF Guide Guide the paper for correct copy.

11 ADF Output Tray Tray for output from the ADF.

12 Control Panel Various function keys and LCD

13 ADF Input Tray Up to 35 sheets of document 

14 Flatbed Cover Press the document on the exposure glass.
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 The Name and Function of Each Part (Back)

No. Name Description

1 Vent Release heat from the inside of the device.

2 Telephone 

Terminal

Terminal for the telephone line

3 Telephone Jack Additional telephone connection.

4 Power Switch Switch on or off.

5 Power Connector Connector for the power cord

6 USB Connector Use this connector to connect the device to the PC.

7 Wi-Fi Connector Wi-Fi port.

8 Ethernet 

Connector

Ethernet port.

9 2-Sided Printer Automatic 2-sided print (Inside the device)
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1
  The Name and Function of Each Part (Functional Part)

 

                

No. Name Description

1 ADF Scan the document from the ADF.

2 Pad Press the document on the exposure glass.

3 Exposure glass Put the document so that its side to be scanned is facing this 

glass.

4 Fusing Unit Lever Press this lever to open the fusing unit cover to remove the 

jammed paper.

5 Input Unit Cover Open this cover to remove the jammed paper in the input unit.

4

1

2

3

5
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4. Control Panel

A3/DLT

  Lamps

The lamp shows the device’s current status. 

Lamp Device Status

OFF Off

White On, Standing by

Red Error

Green Operating

  

    

  Buttons

Use buttons to select a menu, start operation and respond to messages when changing the 

configuration.
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1
Button Function

 Press the 【 】 button to start the current operation.

 Delete messages (error message) on the display panel. 

 Remove the jammed paper and then retry.

 Press the 【◀】 or 【▶】 button to go to the next or previous item.  

  Press the 【◀】 or 【▶】 button to enter the number (e.g., number of sheets).     

  Press the number until the desired number appears.

   Press the 【OK】 button to show the selected menu on the second line of the  

  control panel.

  The menu depends on the type. 

   - When a menu is selected, its item is displayed.

 
 If a new menu item is saved, the device shows the “Saving” message, and   

  then returns to the menu item. 

 Press the 【 】 button to go to the previous menu or menu item.  

Press the 【 】 button to cancel a job in the [Printing] [Scanning] [Copying] 

mode. 

【Copy】 Press the 【Copy】 button to change copy settings. Changed settings are ap-

plied only to the selected job. To maintain the changed setting, press the 

menu button, change the default setting and then save it.

【Scan】 Press the 【Scan】 button to change scan settings.

Save the scan file on the mobile memory or FTP server, or e-mail it.

This setting is applied only to selected jobs.

If you want keep this setting, press the [Menu] button and set the [Scan] 

setting to the default setting.

【 】 Press the 【 】   button to switch from menu setting to standby screen.

【 】 Press the 【 】 button to switch the device from the power-saving mode to 

the stand-by mode.

【Menu】 Press the 【Menu】 button to go to the menu while [Ready] is displayed. 

Various settings can be changed in the menu.  
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Button Function

【DLT】 Press the 【DLT】 button to copy or fax DLT paper according to 

the current function. By default, while the device is [Ready], 

press the 【DLT】 button to copy DLT paper.

【FAX】 Press the 【FAX】 to change fax settings. Changed settings 

are applied only to the selected job. To maintain the changed 

setting, press the 【Menu】button, change the default setting and 

then save it.  

【SPEED DIAL】 Use this button to speed dial the receiver when sending a [FAX]. 

【ON-HOOK】 Use this button to go to the [On-Hook] mode when making a 

call to the receiver to send a [FAX]. 
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15. Power Switch and Energy Saver Mode 

  Power Switch

Before turning on the Power Switch, check that the power cord plug is firmly connected to the re-

ceptacle.

Press the Power Switch on the right-rear side of the equipment to “ㅡ” position (On).

To turn power off, press the Power Switch to “○” position (Off). 

      Warning

  - Never insert or pull of power plug, or touch the Power Switch with wet hands.

    It may cause electric shock.

  

 Important

  - Once the power has been turned off, wait for at least 3 seconds before turning the power   

    on.   

 
  - When the equipment is not to be used or stored for a long time, or moved to another place,  

    turn off power and pull off the plug from the power receptacle.

   

  Energy Saver Mode

When the device has not been operated for a certain time, the device enters Energy Saver Mode 

automatically to reduce electric power consumption.

In the Energy Saver Mode, only the LED indicator of the【 】 button is lit and other LEDs and LCD 

are turned off. The time for entering this mode can be set up between 1~240 minutes. The factory 
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setting is 3 minutes. Pressing the【 】 button terminates Energy Saver Mode.

The user can set up the time according to the work environment.

  Note

         -   In the Energy Saver Mode, reserved sending and receiving of FAX, printing and scanning  

 operation from a PC can be carried out.

         - In the following cases, the equipment will not be changed to Energy Saver Mode:

 While scanning a document

 While copying or printing a fax document, or

 Printing a document from a PC.

- In any one of the following cases, the equipment will exit from Energy Saver Mode auto  

  matically:

 When sending a fax at reserved time

 When receiving a fax

 When receiving a printing job command from a PC, or

 When receiving a scanning job command from a PC.
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1
6. Unpacking 

1 Unpack and install the device where good ventilation is provided. 

 To enable the cooling fan to operate properly, do not place anything 3 cm away from the right   

 side of the device. Avoid following locations: 

 A. Exposed to the direct sunray 

 B. Close to heating equipment or air-conditioner

 C. Dusty place

2 Pull out the device and other components from the box. 

 Keep the box and buffer materials in case you need to pack the device.

3 Remove tapes in and on the device and remove the packing material from the tray.

4 Check if following components are included.

1. Tray 1 (25p sheets by default) 

3. Power cord

2. Enclosed cartridge

4. USB cable

5. Quick Installation Manual

6. Driver CD (User Manual CD Included)

7. Paperport CD

8. Line Cord

5 If any of components are missing or damaged, contact the dealer where you purchase the   

 device.
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7. Cartridge Preparation

Unpack and install the cartridge according to the following order.

1 Cut the bag to the guideline to open it and pull out the cartridge.

 Caution

  -  If the unpacked cartridge is exposed to the direct sunray or strong light, it may be damaged. 

Keep the unpacked cartridge in the shade or cover it with newspaper or other things.

  - Do not touch the green drum. Use the handle. 

2 Remove packing materials.

 Caution

  - Do not touch the green drum at the bottom of the cartridge.
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1
3 Shake the unpacked cartridge so that toner can be evenly distributed.

 Caution

  - Be careful not to be tainted with black toner. 

  - Do not touch the green drum at the bottom of the cartridge.
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8. Cartridge Installation 

1 Press the button on the left side to open the front cover.

   

   

2 Install the cartridge according to the following order.

 A. Hold the cartridge handle. (The back of your hand is facing downward.)

 B.   Align the guides (arrow sticker) of the cartridge to the groove (arrow sticker) of the device.

 C. Push the cartridge into the device until you can hear a click.

3 Close the cover. You can hear a click if the cover is properly closed. 

 If not, the device may not work properly

 Caution

  - Check if the multipurpose tray is closed. 

    If you close the front cover while the multipurpose tray is open, it may cause malfunction. 
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1
9. Print Paper Loading 

The device has trays with a capacity of 300 sheets (tray 1 + multipurpose tray). 

If the tray 2 is added, capacity is increased to 550 sheets. 

For more information on capacity, supported size, and supported media, see the below table.

Capacity 

(Sheet)
Supported Size Supported Media

Tray 1 250 A4, A5, B5, folio, letter, legal, 

executive, statement

Standard paper, label paper, 

thick paper  

Tray 2 250 A4, A5, B5, folio, letter, legal, 

executive, statement

Standard paper, label paper, 

thick paper

Multipurpose 

Tray

50 Paper between 

76.2X127mm(3x5inch) and 

16X355.6mm(8.5x14inch)

Standard paper, label paper, 

envelope, card stock

  Loading

Load paper to the basic or optional tray according to the following order.

 Important

   -  When you change paper for the tray 1, see if paper type and size are correct in the driver.

1 Use the handles on both sides of the tray to remove it.
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2 Hold both width guide tab and width guide, and then push them to the right.

3 Hold both length guide tab and length guide, and then move them to their maximum position.

4 For the legal paper, set the length guide adjustment lever to “Legal” and move the length guide  

 wall to its maximum position. 

 Caution

  - To load paper shorter than A4 paper, set the length guide adjustment lever to “A5~A4” and  

    move the length guide wall to its minimum position.

5 Loosen paper and blow air between papers. 

 Do not fold or wrinkle paper. 

 Load paper with its edge correct. 

Length Guide 

Length Guide Tab

Width Guide Tab

Width Guide  

Length Guide Wall 

Length Guide 

Adjustment Lever
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1

 Important

   - Do not overload paper in the tray. This may cause jammed paper. 

6 Load the paper in a way its print side is facing downward. 

7 Load paper to the limit mark. 

 Caution

  -    For label paper, thick paper and other paper smaller than A5, load it to the Thick mark.

  

8 Hold both width guide tab and width guide, and then push them to the end of paper..

9 Hold both length guide tab and length guide, and then push them to the end of paper.

10 Push back the tray to the device.
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  Load to the Multipurpose Tray 

With the multipurpose tray, you can decide paper size and type on your computer, send the print job 

to the device, and then manually load appropriate paper to print. 

Also, it can be used as the standard tray for automatic printing. 

Load paper to the multipurpose tray according to the following order. 

1 Hold the top of the multipurpose tray to pull it out. 

2 Pull out the extended support. 

3 Unfold the extended support.

Extended Support
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1
4 Push away both width guides wider than paper to be loaded. 

5 Loosen paper and blow air between paper. 

 Do not fold or wrinkle paper. 

 Load paper with its edge correct. 

 Important

   - Do not overload the multipurpose tray. This may cause jammed paper. 

6 Load the paper at the center of the tray in a way its print side is facing upward. Do not use   

 wrinkled paper.

7 Push paper slightly to the device. 

8 Push the width guides to paper slightly. 

Width Guide
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  Installation of the Paper Support 

The paper support holds paper coming from the device so that it can be accumulated without 

falling. 

Unfold the paper support after installing the device.

.
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110. Original

  Supported Original Type

ADF

Copy, Scan and Fax

Max 216 mm X 356 mm (horiz X vert)

Min 140 mm X 148 mm (horiz X vert)

Max. Sheets of Copies for One 

Operation

60 ~ 80 g/m2 : 35sheets

81 ~ 105 g/m2 : 20sheets

Thickness 0.08 mm ~ 0.15 mm

Quality High quality paper or equivalent paper

  

Exposure Glass   

Max 216 mm X 297 mm (horiz X vert)

Min No limit

DLT function is used 279.4 mm X 431.8 mm (DLT size)
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11. Original Placing

  Placing the Original on the ADF

1 Adjust the guides to the original.

                       

2 Push the original with its scan side facing upward until it stops.

         

3 Adjust the guides to the original.
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  Note

         -    Below originals are not available for the ADF.

 Torn original or original with holes

 Wrinkled or bent original

 Wet original or original attached due to electrostatic

 Carbon paper or non-carbon original

 Texture or metal paper

 Original with staples, clips or tapes

 Glued original

 Glossy or specially coated original 
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  Placing the Document on the Exposure Glass

1 Lift the ADF.

 Lift the ADF more than 20°. 

 If the lifting angle is less than 20°, the original may not be detected. 

2 Place the original face-down on the exposure glass with the upper-left corner of the original at  

 the corner indicated by the icon on the scanner.

 

                

    

    

    

3 Lower the ADF.

  Note

         - If the original is loaded to the ADF, the original on the flatbed is not scanned.       

   - Do not press the book on the flatbed too hard.

   - A sharp part may leave a dent on the exposure glass.

ADF
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112. Installation of the Optional Tray 2 

The device supports the optional tray with a capacity of 250 sheets. 

The optional tray 2 consists of the support and the tray. 

 Warning

   - To install the optional tray 2 after installing the device, check if the device is switched off,   

    power cord is unplugged and all cables are disconnected.

1 Remove all packing materials and tapes. 

2 Hold the handles on both sides of the tray 2 to pull it out. 

3 Hold both ends of the support and put it in a place where the device will be located. 
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4 Push back the tray until if perfectly fits into the support. 

 Installation of the Device on the Tray 2 

Use the handles on both sides of the device to place it. 

To install the device on the tray 2, follow below instructions. 

1 Align the tab, groove and connector of the tray 2 to the device. 

2 Place the device on the tray 2. Check if the device fits into the tray 2 correctly. 

Connector

Groove

Tab
Handle
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113. Cable Connection

The device can be directly connected to the PC via the USB cable. 

 Caution

   - While the device is on, do not connect or disconnect any communication ports. 

  USB Cable Connection 

The device can be connected via the USB cable and its USB port supports the USB standard.

1 Check if the other equipments connected to the device is off. 

2 Connect the device to the PC via the USB cable. The USB port needs the USB cable. 

 Check if the symbol on the device matches that on the cable. 

  Network Cable Connection

This device can be directly connected to the network via the standard network cable.

Follow below instructions to connect the device to the network.

 Note

  - Most networks has the 10BaseT/100BaseTX Fast Ethernet port.

  

1 Check if the other equipment connected to the device is off. 

2 Use the standard cable compatible with the user network to connect the device to the LAN or   

 hub.
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3 Switch on the device.

  Wi-Fi Connection (Option)

(Purchase the Wi-Fi module (WN400) separately.)

1 Check if the other equipment connected to the device is off.

2 Connect the Wi-Fi module to the USB port on the back of the device.

 (※ The module is automatically recognized.) 

3 Switch on the device. 
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1 Important

  - In general, it is not recommended to connect both network cable and Wi-Fi module to 

    the device at the same time. If wire/wireless data enters the device at the same, a problem  

    can occur.

  - If the device is connected to the network via the network cable, remove the Wi-Fi module  

    and vice versa.

    - Check if the device is off when installing or removing the Wi-Fi module.

4 Check if the LED is on when the Wi-Fi module is connected.
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14. MFP Driver Installation 

The MFP driver is software enabling communication between PC and device. 

The scanner driver and the printer driver are provided for the MFP. 

In general, software is installed during initial setting of the device. To install software, follow below 

instructions. 

1 Close all open programs on your PC. 

2 Insert the software CD. 

3 Click [Install] on the dialogue window. 

4 Follow instructions on the screen. 

  Update of Options Available for the MFP Driver 

After installing MFP software and options, to do print jobs, you may need to install additional op-

tions manually. 

For Windows Users 

1 Click Start and click Execute.

2 Press Start and type “control printers” into the execution dialog box.

3 Press Enter or click OK to open the printer folder. 

 Or follow below instructions. 

  
 Click Start from the Window menu.

 
 -  Window 2000: Select Configuration > Printer.

 -  Window XP/2003: Select Printer and Fax. 

 -  Window 2008/Vista: Go to Control Panel > Hardware and Sound > Printer. 

 -  Window 7: Go to Control Panel > Hardware and Sound > Device and Printer. 

 -   Window Server 2008 R2: Go to Control Panel > Hardware > Device and Printer. 

   

4 Select SINDOH M402_408 Series.
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5 Right-click SINDOH M402_408 Series.

6 Window XP/2003/2008/Vista: Click Print Default Setting. 

 Window 7, Window Server 2008 R2: Click Print Default Setting from each menu. 

7 Click the device setting tab. 

8 Add installed hardware options from available options.

9 Click Apply. 
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15. MFP Setting Check 

  Switch On 

1 Connect the end of the power cord to the port on the back of the device and plug the power   

 cord to the properly grounded wall outlet. 

2 Switch on the device. 

 When initial warming-up is complete, the [Ready] message appears to indicate that the device 

 is  ready to receive data. 

 If the message other than [Ready] appears, see  P. 5-19 「Understanding of Messages」  

3 Check your PC and see if other equipments are on. 

4 Move to the next step. 

   System Report Printing 

Print the system report to see initial settings and check if options are properly installed. 

1 Check if the device is on. 

2 Press the 【MENU】 button. 

3 Press the 【◀】 or 【▶】 button until [Reports] appears. 

 Then, press the 【OK】 button. 

4 Press the 【◀】 or 【▶】 button until “System Report” appears. 

 Then, press the 【OK】 button. 

5 Press the 【◀】 or 【▶】 button until “System Report” appears. 

 Then, press the 【OK】 button. 

6 Check the tray and paper type. 
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  Network Report Print 

Print the Network Report to check network settings.

See network settings such as IP in the network report to change network settings.

1 Check if the device is on.

2 Press the 【MENU】 button.

3 Press the 【◀】 or 【▶】 button until [Report] appears.

 Press the 【OK】 button.

4 Press the 【◀】 or 【▶】 button until [Network Report] appears.

 Press the 【OK】 button.

 

 Note

  - To print from the network, enter the correct IP to the port field in the device’s deriver.

  - The netmask should match the gateway.

  - If the IP address is DHCP, no additional settings are required.

  - If DHCP is selected, the IP address can be changed according to network environments.

    If the device is not connected to the network, check the allocated IP address. If the IP   

    address keeps changing, contact your network administrator.
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16. Tray Specifications 

This section deals with information on paper types and paper feeding specifications used in the 

MFP. For more information, see the paper guideline, especially card stock or label paper. 

      

Type/Capacity Size Weight  

Tray 1 Standard Paper : 250 sheets

Label Paper : 50 sheets Note1

Thick Paper : 100 sheets Note1

A4, A5, B5,

Folio, Letter, Legal,

Executive, Statement

60~105g/m²

(16~28lb)

Tray 2 Standard Paper : 250 sheets

Thick Paper : 100 sheets Note1

A4, A5, B5,

Folio, Letter, Legal,

Executive, Statement

60~105g/m²

(16~28lb)

Multipurpose 

Tray

Standard Paper : 50 sheets 

Envelope : 5 sheets

Label Paper : 15 sheets

Card Stock : 5 sheets

Paper between 

76.2X127mm(3x5inch) and 

216X355.6 (8.5x14inch)

60~166g/m²

(16~53lb)

Card Stock : 

90lb  

      Note1 :   Upload label paper or thick paper up to the maximum level of tray 1. The capacity can  

 vary according to paper thickness.

        Upload label paper or thick paper up to the maximum level of tray 2. The capacity can  

 vary according to paper thickness.

For 2-sided printing

Paper Weight Feeding

A4, Letter Standard Paper: 60~90g/m (16~24lb) From the tray 1

 Caution

   - Though the multipurpose tray can accommodate 50 sheets normally. According to 

    paper thickness, 10 more sheets can be added. However, for optimal performance, load  

    50 or less sheets.
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117. Paper

  Automatic Feeding 

When the currently-selected tray becomes empty, the device switches automatically to another tray 

with paper of the same size and type. 

Feeding Order 

When automatic feeding is on, trays are switched in the below order: 

Tray 1 → Tray 2 (Option) → Manual Tray
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18. Certificate 

  Environment-Friendly Product  

The device is the environment-friendly product which creates relatively less pollution during its 

production and operation and provides accurate environment information for customers so that they 

can make informed decisions. 

If you use the device, you are helping the environment indirectly. 

  Energy Saving Mark 

The device is designed and manufactured for efficient energy use. 

The energy saving mark is given to only qualified products. 

This mark indicates that the product satisfies energy saving requirements of the Korean government 

and is registered as the energy saving product to Korea Energy Management Corporation. 

The product with this mark is 30 - 50% more energy efficient than other products. 
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119. Installation and Operation Information 

For more information on installation and operation, refer to the accompanied CD or go to the web-

site. You can see information on device installation and disassembly, supply installation and re-

placement, paper feeding, and CD for driver and utility installation. 

   Driver CD and Manual 

The driver CD contains the printer driver and scanner driver necessary to operate the device. Also, 

it has utilities, relevant documents and manuals

   Quick Guide and Manual 

The quick guide shows how to install and use the device. The manual on the CD fully describes 

installation, general operation, messages, functions and troubleshooting.  

   Website

Go to www.sindoh.com to download drivers, utility updates, relevant documents and other 

information. 
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1. Copy

Basic Operation  

1  Place the original on the flatbed or ADF. For more information, see  P. 1-24 「Original Placing」  

2 Press the 【Copy】 button to go to the setting mode.

3  Select necessary settings. 

 Available settings are paper type, scale, scan quality, scan density, and sort. For more 

 information, see P. 2-6 ~ P. 2-13 

4   To make multiple copies of the scanned original, press the 【Copy】 button. Then, press the 【◀】 

or 【▶】 button until [No. of Copies] appears, and press the 【OK】 button. 

5 Press the 【◀】 or 【▶】 button to decide the number of copies and then press the 【OK】 button.   

 You can set 1 ~ 99. If you do not set the number of copies, one copy is made. 

6 Press 【 】 the button to start copying. 

  Note

        -  Press the 【 】 button to cancel copying.

        -  Reset settings, to press the 【 】 button more than two seconds.

  Copy Setting Table 

Copy 　

No. of Copies 

Original Size 

Paper Size 

Paper Source 

Contents

Darkness

Brightness

Contrast

Background Remove 

Scale

Copy Type  
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Duplex

Collate

Detailed Description of Copy Settings 

Setting Description Value

No. of Copies Number of copies to be made * Available: 1 ~ 99  

Original Size Size of the original document * A4, A5_SEF, A5_LEF, B5, Letter, 

Legal, Executive, US Folio 

Paper Size Size of paper to be used for 

copying

Tray 1 or Tray 2 for [Paper Source]: 

* A4, A5 SEF, A5 LEF, B5, Letter, 

Legal, Executive, Statement, US 

Folio, Quatro, G.Letter, G.Legal 

 MPT for [Paper Source]: * A4, 

A5 SEF, A5 LEF, B5, B6, Letter, 

Legal, Executive, Statement,US 

Folio, Quatro, G.Letter, G.Legal, 

Card 100x148, Card 148x200, 

Card 200x148, Monarch Envelope, 

Com9 Envelope, Com10 Envelope, 

C5 Envelope, C6 Envelope, DL 

Envelope 

Note

 -  [Paper Size] appears only when 

Tray 1, Tray 2 or MPT is selected 

for [Paper Source]. 

 -  Tray 2 appears only when the 

optional tray is installed.  

Paper Source Tray to be used for copying * Auto Size Match, Tray 1, Tray 2, MPT

Note

 -  Tray 2 appears only when the 

optional tray is installed.   

Contents Content of the original document Text, * Text/Photo, Photo  

Darkness Darkness of the copy 1~10, * 6 

Brightness Brightness of the copy -4~4, * 0 

Contrast Contrast of the copy -2~2, * 0 
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Setting Description Value

Background 

Remove

Background removal intensity -4~4, * 0

Scale Scale of the copy * Auto Scale, 50~200

Copy Type Available for ID copy or combined 

copy

* Normal, ID Copy, 2-up, 4-up  

Duplex 2 sided copy of the original * Off, Long Edge Feed, Short Edge   

   Feed

Collate Collate multiple copies into sets * Off, ON 

      (*) is Factory setting 
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Changing Basic Copy Settings    

1  When the device is ready, press the 【Menu】 button.

2 Press the 【◀】 or 【▶】 button until [Settings] appears, and then press the 【OK】 button.

3  Press the 【◀】 or 【▶】 button until [Copy Settings] appears, and then press the 【OK】 button. 

4  Press the 【OK】 button to select the menu on the second line of the LCD or menu item.

      A. Select the menu to open and show the first setting.

 B. Select the menu item to show its default value. Each menu item has a list of values. 

   They consist of word, phrase, number or On/Off. 

5 Press the 【◀】 or 【▶】 button to go to the desired value.

6  Press the 【OK】 button to select the value on the second line of the LCD. A new value is saved 

when you press the 【OK】 button. Press the 【 】 button to go to the previous menu. 

 Customer settings are used until new settings are saved or settings are reset to factory settings.  

 Change settings to your environments.  
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2. Basic Copy 

You can change basic copy settings. Press the 【Menu】 button to change basic copy settings. 

You can set the number of copies up to 99. 

1  Press the 【Copy】 button to go to the copy mode setting menu. 

2 Press the 【◀】 or 【▶】 button until [No. of Copies] appears and then press the 【OK】 button. 

3 Press the 【◀】 or 【▶】 button to determine the number of copies. 

 You can set the number of copies 1 ~ 99. 

1

Paper/Original Size Selection   

Select the tray with paper to be used and then start copying. 

1 Place the original.

2 Press the 【Copy】 button to go to the copy mode setting menu.

3  Press the 【◀】 or 【▶】 button until [Original Size] appears, and then press the 【OK】 button. 

4 Press the 【◀】 or 【▶】 button to select the size of the original document, and then press the   

 【OK】 button.

5 Press the 【◀】 or 【▶】 button until [Paper Source] appears, and then press the 【OK】 button. 
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6 Press the 【◀】 or 【▶】 button to select the tray, and then press the 【OK】 button. 

7 Press the 【◀】 or 【▶】 button until [Paper Size] appears, and then press the 【OK】 button

8 Press the 【◀】 or 【▶】 button to select the paper size, and then press the 【OK】 button

  Note

        -   [Paper Size] appears only when Tray 1, Tray 2 or MPT is selected for [Paper Source]. 

9 Select reduction/enlargement settings. If they are not selected, copies are automatically 

 reduced or enlarged according to the size of the original and paper. 

10 Enter the number of copies. 

11  Press the 【 】 button to start copying.

Copy Mode and Density    

Set the copy mode and density according to the structure and content of the original. 

1 Press the 【Copy】 button to go to the copy mode setting menu. 

2 Press the 【◀】 or 【▶】 button until [Contrast] appears, and then press the 【OK】 button. 

 [Text] - Suitable for text documents. 

 [Text/Photo] - Suitable for documents with texts and images. 

      [Photo] - Suitable for photo documents 

3  The selected paper type is set. 

Darkness/Brightness/Contrast/Background Remove  

1  Press the 【◀】 or 【▶】 button until [Darkness]/[Brightness]/[Contrast]/[Background Remove] ap-

pears, and then press the 【OK】 button.

2 Press the 【◀】 or 【▶】 button to select the desired value, and then press the 【OK】 button. 
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Reduction/Enlargement Setting    

Reduce or enlarge copies to the paper size. Reduction/Enlargement settings between original and 

paper can be selected manually or automatically. 

   Automatic Reduction/Enlargement                       Custom Reduction/Enlargement 

             (Fit to Paper Size)                                                     (1% Step)

 

Auto Scale     

Select the scale to fit to the specified paper size. 

1 Press the 【Copy】 button to go to the copy mode setting menu. 

2  Press the 【◀】 or 【▶】 button to decide [Original Size], [Paper Size] and [Paper Source], and 

then press the 【OK】 button.

3  Press the 【◀】 or 【▶】 button until [Scale] appears, and then press the 【OK】 button.

4 Select [Auto Scale], and then press the 【OK】 button. 

5 Press the 【 】 button.

Custom Scale (Zoom) 

You can select a scale of 50% ~ 200% in a step of 1%. 

1  Press the 【Copy】 button to go to the copy mode setting menu.

2 Press the 【◀】 or 【▶】 button to decide [Original Size], [Paper Size] and [Paper Source], 

 and then press the 【OK】 button.

200%150%100%75%50%
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3 Press the 【◀】 or 【▶】 button until [Scale] appears, and then press the 【OK】 button.

4 Press the 【◀】 or 【▶】 button to select the customer scale. 

5 Press the 【 】button to make copies with a selected scale.  
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3. Advanced Copy  

Combined Copy  

Several pages can be combined into one sheet

                       

         

                    

Two pages into one sheet                                            Four pages into one sheet 

  Note

        -  Two or four pages can be combined into one sheet.

        - The scale is automatically selected. Select the combined copy setting, and then set the   

    scale.

        - Images can be truncated according to the size of the original document and paper.

        - If the page of the original document is less than that of combined copy, the gap will be   

  `  printed blank. 

Setting  

1 Press the 【Copy】 button to go to the copy mode setting menu. 

2 Press the 【◀】 or 【▶】 button until [Copy Type] appears, and then press the 【OK】 button. 

3 Press the 【◀】 or 【▶】 button to select [2-up] or [4-up], and then press the 【OK】 button.  

4 Select other settings if necessary. 

5 Press the 【 】 button.

6 When scanning is complete, “Scan Next Page” appears. 

7 Press the 【 】 button again.  

8 For more than three pages, repeat  6  ~ 7  

      - When the ADF is used,  6  ~ 8  are unnecessary. 
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ID/Card/OHP Copy 

Both sides of the ID, business card or credit card can be copied into one sheet. 

ID/Card Copy 

1  Press the 【Copy】 button to go to the copy mode setting menu. 

2 Press the 【◀】 or 【▶】 button until [Copy Type] appears, and then press the 【OK】 button. 

3 Press the 【◀】 or 【▶】 button to select [ID Copy], and then press the 【OK】 button. 

4 Press the 【◀】 or 【▶】 button to select [ID Copy], and then press the 【OK】 button.

5 Press the 【 】 button to scan the ID. 

6 Flip the ID and press the button to scan its opposite side. The scanned image is printed.
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OHP Copy 

To prevent the roller mark or shade images, place a book and white LETTER paper over the OHP to 

make a copy. 

BookA4 Paper

Duplex

Two pages of the original document can be printed into both sides of paper.

How to make 2-sided copies

1  Press the 【Copy】 button to enter the copy setting mode.

2 Press the 【◀】 or 【▶】 button until [Duplex] appears, and the press the 【OK】 button.

3 Press the 【◀】 or 【▶】 button to select [Long Edge Feed] or [Short Edge Feed], and the press   

 the 【OK】 button.

4 When the flatbed is used, after the document is scanned, “Scan Next Page” appears. 

 Then, place the other side on the flatbed and press the 【 】 button. Two pages of the document  

 are copied into both sides of paper.

 The first scanned page is copied into the front side of paper. 

 

5 If the ADF is used, the even numbered page is copied into the front side, and odd numbered   

 page is copied into the back side.
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                                                                                      [Long Edge]

                                                                                      [Short Edge]

                        
                     

                             Two pages of the document are copied into both sides of one paper

  Note

         -  2 Sided Copy is available only for LETTER or Letter Paper.

  -  2 Sided Copy can be used with Combined Copy.

 

Reduction of DLT to LETTER

The DLT paper can be reduced to the LETTER paper.   

Preparation for DLT Document Scanning 

1 Place the DLT size original on the exposure glass with its upper-left corner at the LETTER scan                 

 point.

                                                                           

2 Lower the ADF slowly.

ADF
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3 Press the 【DLT】 button. The scanned document is reduced to the LETTER paper. 

 Due to the margin, the height to width ratio can be a little different.

 Caution

   -  When you scan, fax or copy DLT documents, a slight mismatch of images may occur in the  

      overlapping part.  

     So, this function may not be suitable for the documents that require accuracy. 

  - If you scan DLT documents more than twice in a row, they may be misaligned due to dis  

     placement. So, fix the DLT document at the LETTER scan point page after page basis.

  - If the DLT document is thick or slippery, its later part may not be scanned. In this case, clean  

     the roller with alcohol or clean water, and then retry.
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1. Driver Installation  

The MFP driver is software enabling communication between PC and device. 

The MFP driver and the scanner driver are provided for the MFP. 

In general, software is installed during initial setting of the device. To install software, follow below 

instructions. 

 

1  Close all open programs on your PC. 

2 Insert the software CD.

3  Click [Install] on the dialogue window.

4  Follow instructions on the screen.   

  Update of Options Available for the MFP Driver

After installing software and options, to do print jobs, you may need to install additional options 

manually.

For Windows Users 

1 Click Start and click Execute. 

2 Press Start and type “control printers” into the execution dialog box.

3  Press Enter or click OK to open the printer folder. Or follow below instructions.

 
Click Start from the Window menu.

 
 -  Window 2000: Select Configuration > Printer.

 -  Window XP/2003: Select Printer and Fax. 

 -  Window 2008/Vista: Go to Control Panel > Hardware and Sound > Printer. 

 -  Window 7: Go to Control Panel > Hardware and Sound > Device and Printer. 

 -  Window Server 2008 R2: Go to Control Panel > Hardware > Device and Printer. 

4 Select SINDOH M402 Series.

5  Right-click SINDOH M402 Series.
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6 Window XP/2003/2008/Vista: Click Print Default Setting.  

      Window 7, Window Server 2008 R2: Click Print Default Setting from each menu. 

7 Click the device setting tab. 

8 Add installed hardware options from available options.

9 Click Apply.
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2. Scan with the PC 

With the TWAIN compatible program, you can scan from your PC. 

The scanned file can be edited and stored with the application program.

  Scan with the PC 

With the TWAIN compatible program, you can transfer the scanned document to your PC.

1  Run the TWAIN compatible program.

2  Scan the document with the program. Scanning procedures vary by program.

 For more information, see the program manual.

3  Select the scanner.

       Select “SINDOH M400 Series Twain Driver”.

4  Select scan setting from the scanner driver.  

For more information, see 「Scan Driver Setting Menu」 (P. 3-6).

5 Place the original in the flatbed or ADF.

 For more information, see  「Original Placing」(P. 1-24). 

6  If you want to scan a part of the original, select the 【Preview】 button on the scan driver to scan 

it at a low resolution. To scan the whole document, go to 8  .

7  Select the scan area in the preview window.

8  Press the 【Scan】 button to start scanning.

9 The scanned image is transferred to the program.

  Note

        -  [Preview] is available only when [Original Set Type] is [Flatbed].  
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[Twain Scanner Driver for M400 Series]
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Scan Driver Setting Menu 

Setting Group
Setting 

Menu
Option Description

Original Set 

Type  　

　 Flatbed, 

ADF, A3 Unit

Decide a location where the original is 

placed. 

Standard 

Presetting

Original 

Size

Letter, Legal 

Executive, 

Folio

Select the size of the original to be scanned. 

Only when the ADF is selected, Legal and 

Folio are available. 

A4, A5, B5, 

Custom Size

Max. custom size: Width 215mm, Height 

297mm  

Original 

Orientation

Portrait By default, “Portrait” is selected. When “A5” 

is selected in the presetting, it is available.

Landscape In the “advanced setting”, the resolution is 

“300x300dpi,” and color type is “Gray.”

Photo Select Button In the “advanced setting”, the resolution is 

“300x300dpi,” and color type is “Color.”

Document Select Button In the “advanced setting”, the resolution is 

“150x150dpi,” color type is “Black/White,” 

and the halftone mode is “Threshold.”
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Setting Group
Setting 

Menu
Option Description

Advanced Resolution 75x75dpi Select the resolution of the scan image.

The higher resolution provides better image 

quality, however, the scan file size becomes 

larger.

100x100dpi

150x150dpi

200x200dpi

300x300dpi

600x600dpi

Color Type Black/White Select color according to the color of the 

original and purpose. 
Gray

Color

Contrast -20~20% Set up the color contrast of the scan image.

The higher the value, the higher the contrast 

ratio becomes.  

Brightness -60~60% Set up the brightness of the scan image.

The higher the value is, the brighter the 

output becomes.

Halftone 

Mode

Threshold Available only when the color type is “Black/

White”.  

Setting Group
Setting 

Menu
Option Description

Error 

Diffusion

In general, [Threshold] is suitable for 

documents with only texts. 

[Error Diffusion] is suitable for documents 

with both texts and images or images only.  

Preview Select Button See the scan output in advance or select the 

scan area.

Scan Select Button Select this menu to start scanning.

End Select Button Select this menu to end the scan driver.

Version Select Button Version of the scan driver
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3. DLT Document Scan  

The DLT document can be scanned for storage in a PC.

  Preparation for DLT Document Scan 

1  Place the DLT paper on the exposure glass with its upper-left corner at the A4 scan point 

indicated by the icon on the scanner. 

2 Lower the ADF slowly. 

3 Select the scanner.

      Select “SINDOH M402 Series Twain Driver”.

4  Set the original set type to DLT in the Scan Setting of the scanner driver. 

5  Press the 【Scan】 button to start scanning. 

6  The scanned image is transferred to the program. 

 Caution

  - When you scan, fax or copy DLT documents, a slight mismatch of images may occur in the  

    overlapping part.  

    So, this function may not be suitable for the documents that require accuracy.

  - If you scan DLT documents more than twice in a row, they may be misaligned due to 

    displacement. So, fix the DLT document at the LT scan point page after page basis.

  - If the DLT document is thick or slippery, its later part may not be scanned. In this case,   

    clean the roller with alcohol or clean water, and then retry.

ADF
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4. Scan from the MFP

The scanned image can be saved on the USB memory, e-mailed or saved on the FTP server.

  Scan with the USB Memory 

Connect the USB memory to the device to save the scanned image on it.

1 Connect the USB memory to the device.

                                   

2 Place the original.

3  Press the 【Scan】 button.

4 When [Where to scan] appears, press the【OK】button.

5 Select [Scan to USB], and press the【OK】button.

6  Select the document type, contrast, resolution and scale if necessary.

7 Press the 【 】 button to save the scanned document on the USB memory.

  Note

  - The scanned image is saved in a format of YYMMDDMMSS.

    For example, if scanning took place at 12:30:30, January 1, 2011. 

    The file name will include “110101123020”.

  - To reset settings, press the 【 】 button two seconds or longer.
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  E-mail the Scanned File

If the device is connected to the network, you can e-mail the scanned image directly.

Set the e-mail server in [Network Settings] before e-mailing the scanned image.

Set the SMTP server in [Setup E-mail Server].

1 Place the original.

2 Press the 【Scan】 button.

3 Press the 【OK】 button when [Where to scan] appears.

4 Select [Scan to Email], and then press the 【OK】 button.

5 If necessary, set the document type, contrast, resolution, and scale.

6 Press the 【 】 button to start a job.

7 In [Email enter from], enter the receiver’s e-mail address.

 ① Search Address Book: Select the receiver from the address book.

 ② Direct Input: Type in the new e-mail address. When the new e-mail address is entered, you   

 are asked if you want to save it. If you select Yes, the new e-mail address is saved in the   

  address book and then can be selected from the address book in the future.

8 After selecting or typing in the e-mail address, press the 【OK】 button to start scanning and 

 e-mail the scanned image.

9 ⑨ The scanned image is attached to the e-mail.

Access the device web to edit or add the e-mail server setting and e-mail address book. 

For more information, see 「Setting with the Web Image Monitor」 (P. 4-2).

Follow below instructions to make settings from the control panel. 

E-mail Server Setting

1 Press the 【MENU】 button.

2 Press the 【◀】 or 【▶】 button until [Settings] appears, and then press the 【OK】 button. 

3 Press the 【◀】 or 【▶】 button until [Network Settings] appears, and then press the 【OK】 button.
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4 Press the【◀】or 【▶】 button until [Setup MailServer] appears, and then press the 【OK】 

 button. 

5 Follow below steps.

 ① Enter the e-mail server address to [Server Address]. For example, if you want use Google   

 gmail, enter “smtp.gmail.com”.

 ② Select [Authentication]. Decide whether or not to use password.

 ③ Enter [Email ID]. Enter your e-mail address registered to the e-mail server.

 ④ Enter [Password]. Enter the password to your account.

 ⑤ Select [Secure Connect.] and [Server Port].

 Contact your e-mail server administrator or service provider for [Secure Connect.] and    

 [Server Port].

Alphanumeric Pad

Use the key pad, or 【◀】 or 【▶】 button to enter the address or password.

1 Press the number key, then character in the key appears one by one.

 The character appears in order of lower case, number and upper case.

2 In the character mode, press the 【 】 button to change the available character group.

 There are four character groups for your convenience: number (0 ~ 9), lower case (a~z), upper  

 case (A ~ Z), and symbol (@, #, %).

3 Press the 【 】 button to switch to the character group.

 The character group appears in order of lower case > special character >  (Enter) > 

 number > upper case.

 Press the 【 】  button to switch to the character group, and then press the number key to enter  

 the character.

4 Press the 【◀】 or 【▶】 button to show all character groups..

5 Enter one character, and then press the 【OK】 button. The cursor goes to the next space.

 Or press another number key to go to the next space.

6 When entering is complete, press the 【 】 button to switch the character group to, and then   

 press the 【OK】 or 【 】 button. The entered value is saved, and you go to the next field.

7 Press the 【 】 button to delete the character.
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8 To cancel entered values, delete all characters and press the 【 】 button to go to the upper   

 menu.

  Send the Scanned Image to the FTP Directly

If the device is connected to the network, the scanned image can be sent to the FTP server directly. 

1 Place the original.

2 Press the 【Scan】 button.

3 When [Where to scan] appears, press the 【OK】 button.

4 Select [Scan to FTP], and then press the 【OK】 button.

5 If necessary, set the document type, contrast, resolution, and scale.

6 Press the 【 】 button to start the job.

7 In [FTP enter from], enter the FTP server address.

 ①  Search Address Book: Select the FTP address from the address book.

 ②  Direct Input: Type in the new FTP address. When the new FTP address is entered, you are

 asked if you want to save it. If you select Yes, the new FTP address is saved in the address   

 book and then can be selected from the address book in the future..

8 After selecting or typing in the FTP address, ID and password (if required), press the 【OK】 

 button to start scanning and send the scanned image to the designated FTP. 

9 For more information, see  「Alphanumeric Pad」 (P. 3-11).

Access the device web to edit or add the FTP server setting and FTP address book. For more infor-

mation, see 「Setting with the Web Image Monitor」 (P. 4-2).
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  Note

  - The scanned image is saved in a format of YYMMDDMMSS.

    For example, if scanning took place at 12:30:30, January 1, 2011. The file name will in  

    clude “110101123020”.

  - Some portal mail does not allow e-mail transfer from external access. If e-mail transfer   

    keeps failing, contact the e-mail service provider.

  - Access to some FTP servers is allowed due to the firewall. If transfer to the FTP server   

    keeps failing, contact the FTP server administrator.

  - To reset settings, press the 【 】 button two seconds or longer.
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  Scan Setting Table  

Scan 　

Where to scan

Original Size 

Color 

Resolution 

File Format 

JPEG Quality 

Brightness 

Contrast 

   Detailed Description of Scan Settings

Setting Description Value

Where to scan Location where scanned files 

are saved

*Scan to USB, Scan to Email, Scan to    

  FTP

Original Size Size of the document to be 

scanned

*  A4, A5 SEF, A5 LEF, B5, Letter, Legal, 

Executive, US Folio 

Color Color of the document to be 

scanned

Color, * Gray, B/W Text, B/W Photo 

Resolution Resolution of the document 

to be scanned

75x75dpi, 100x100dpi, 150X150dpi, 

200X200dpi, * 300x300dpi, 600x600dpi

File Format File format of the scanned 

image

* PDF, JPG, TIFF 

JPEG Quality Quality of JPEG files * Low, Mid, High  

Brightness Brightness of the document 

to be scanned

-4~4, * 0 

Contrast Contrast of the document to 

be scanned

-2~2, * 0 

       (*) is Factory Setting 
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5. Print from the PC 

Install the MFP driver to use the device as your printer.  

  Print

Printing procedures vary by program. For more information, see the program manual.

1  Open the document with the program.

2 Go to [File] > [Print].

3  Check if the printer driver installed on the device is selected. 

 If necessary, go to [Configuration] to make necessary adjustments.

4  Press [Print] to start printing.

  Canceling Print Jobs

Cancel with the Button on the Control Panel 

To cancel a print job under processing, [Printing] should appear. 

1  While [Printing] is displayed, press the 【 】 button.  

2 When [Cancel Job?] appears, press the 【 】 button. 

3 To resume the print job, when [Cancel Job?] appears, press the  【 】 button.

Cancel from the My Computer 

1   Open the printer folder. For information on how to open the printer folder, see 1  ~ 3  of 

 ` 「Entering the Basic Print Setting」 (P. 3-17).

2  Double-click SINDOH M402 Series. 

The print job list appears.

3 Select jobs you want to cancel.
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4   Press the [Delete] key.

  Note

  - Depending on your OS, procedures to check the MFP may be different. 

    For more information, see the user manual or help on your OS.

 



3-17

Scanner, Printer and Fax 

3

6. Change Print Settings of the MFP 

Change print settings of the MFP driver to use wanted functions. 

This section describes functions of the printer MFP and how to use them. 

Detailed information on functions will be provided. For easy understanding, functions are explained 

by each tab of the printer driver. 

Also, help of the printer driver provides the same description. 

  Entering the Basic Print Setting 

For Windows Users 

1 Click Start and click Execute.

2 Press Start and type “control printers” into the execution dialog box.

3  Press Enter or click OK to open the printer folder. 

 Or follow below instructions. 

 Click Start from the Window menu. 

  - Window 2000: Select Configuration > Printer. 

  - Window XP/2003: Select Printer and Fax. 

  - Window 2008/Vista: Go to Control Panel > Hardware and Sound > Printer. 

  - Window 7: Go to Control Panel > Hardware and Sound > Device and Printer. 

  - Window Server 2008 R2: Go to Control Panel > Hardware > Device and Printer. 

 

4  Select SINDOH M402 Series.

5  Right-click SINDOH M402 Series.

6  Window XP/2003/2008/Vista: Click Print Default Setting. 

Window 7, Window Server 2008 R2: Click Print Default Setting from each menu.

  Help

1 Open the basic print setting window and press the [F1] key.

      - Or click [Help] on the right bottom of the window.
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2 Select “1” and “2” to open the help window on functions provided by the driver.

  Advanced Functions in Each Tab

Functions in the Print Setting Tab

Available functions are “Job Type,” “Copies,” “Orientation,” “2-Booklet” and “Pages per Sheet”. 

Open the basic print setting window to select the print setting tab to change print settings. 

        

                  (SINDOH M402 Series)                 (SINDOH M402 Series PS/PCL5e/PCL6)

Copies  

The driver makes it possible to print multiple copies. Also, it is possible to collate multiple copies 

into sets. Open the basic print setting window to select the print setting tab to change below print 

settings. 
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                  (SINDOH M402 Series)                 (SINDOH M402 Series PS/PCL5e/PCL6)

Description

Copies

      - Type in or use up/down arrows to decide the number of copies. 

Collate

      - You can set the product to automatically collate multiple copies into sets. For example, if   

   you are making two copies of three pages and the automatic collation is on, the pages   

  print in this order: 1,2,3,1,2,3. If automatic collation is off, the pages print in this order:   

  1,1,2,2,3,3. The application precedes this setting and can provide this function. 

Printing Order

      -  Available functions are “Normal”, “Reverse”, “Odd” and “Even”

      -  Available only for SINDOH M402 Series.

Orientation 

You can set orientation: Portrait or Landscape. Portrait mode and Landscape mode arrange the 

shorter and longer sides of the paper on top, respectively. Most applications support “Page Setting” 

(paper orientation) function which precedes this setting. You can rotate the page by 180° as nec-

essary. Open the basic print setting window and select the print setting tab to change below print 

settings.
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Duplex  

Select “Duplex” to print both sides of paper. 

Select paper orientation before printing. 

Open the basic print setting window to select the print setting tab to change below print settings. 

(SINDOH M402 Series PS/PCL5e/PCL6) 

Procedure

1 Select orientation

그림 묶음 방향 내용

1 Side Print Print on the one side.  

Long Edge (Horizontal Flapping) Mainly used for books.  

Short Edge Mainly used for calendars.  

2 Click the paper tab to select paper size, paper source and paper type

3  Click OK or Print before exiting the window. 
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2-Booklet Printing 

With this function, you can do 2-sided printing and then bind printed pages into a book. 

Open the basic print setting window to select the print setting tab to change below print settings.

Procedure

1  Click the print setting tap and click Print 2-Booklet in Pages per Sheet.

2 Click the paper tab to select paper size, paper source and paper type.

3 Click OK or Print before exiting the window.

4 Fold paper in half and bind it. (You can cut paper in half and bind it.)

Pages per Sheet

Multiple pages can be printed on one sheet. If the number of pages to be printed is less than that of 

pages designated for the sheet, blank pages are printed. The booklet is a special format of 2-up. 

In booklet printing, fold output pages to make a book. If poster print is selected in the image driver, 

“Pages per Sheet” cannot be selected. Open the basic print setting window to select the print 

setting tab to change below print settings.
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Description

Number of Copies for Pages per Sheet(Select the number of copies for Pages per Sheet)

  -  SINDOH M402 Series: 1 sheet, 2 sheets, 4 sheets, 6 sheets, 8 sheets, 9 sheets, 

   12 sheets, 16 sheets, 25 sheets

 -  SINDOH M402 Series PS/PCL5e/PCL6: 1 sheet, 2 sheets, 4 sheets, 6 sheets, 8 sheets, 

   9 sheets, 16 sheets

Page Borders

      - Check Page Borders to print the page edge on the paper.

First Page -Layout

      -  From page 2, it can be set. Left and right are available for page 2.

      -  For page 4 to 25, rows (Upper/Lower  left, Upper/Lower  right) and columns (Upper/Lower  

left, Upper/Lower  right) are available.

          

                       

                                            [Page 2]                                 [Page 4  ~  25]    

    

Paper Tab 

Available functions are “Paper Size,” “Print On,” “Custom Sizes,” “Zoom,” “Tray,” “Media Type,” and 

“More Input Options.”

Open the basic print setting window to select the paper setting tab to change below print settings. 
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Print On

Regardless of the size of the original, you can print the document to desired paper size. 

Useful options (Fit to Paper and Center) are available. 

Open the basic print setting window to select the paper setting tab to change below print settings.

Zoom

You can zoom in or out the document. Type in or use up/down arrows to decide the zoom ratio. 

Click Center to place the document at the center of paper. 

The scale function of the PDL printer driver cannot be used with the poster function in the advanced 

tab.

Open the basic print setting window to select the paper setting tab to change below print settings. 

More Input Options 

Available options are “Front Cover,” “Back Cover,” “Interleaves Pages,” “Margins,” and “Shift From 

Binding.” Open the basic print setting window to select the paper setting tab to change below print 

settings. 
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Description

Front/Back Covers

 -  You can make the front cover or back cover.

 -  SINDOH M402 Series: Empty cover only

 -  SINDOH M402 Series PS/PCL5e/PCL6: Empty cover, printed cover

 -  The tray and paper type can be selected.

 -  The cover is not available for 2-Sided Print and Poster Print.

      

                     (SINDOH M402 Series)                 (SINDOH M402 Series PS/PCL5e/PCL6)

Interleaves Pages

      -  Add the page of the Interleaves Pages.

 -  For the Interleaves Pages, you can select the different paper and tray from other papers. 

 -  The Interleaves Pages can be a blank page or a duplicate of a printed page.

 -  The Interleaves Pages should have the same size as normal pages. 

 -  The Interleaves Pages is not available for 2-Sided Print and Poster Print.

                 

                (SINDOH M402 Series)                 (SINDOH M402 Series PS/PCL5e/PCL6)
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Margins

 - The minimum margin can be modified. Select “Printer Margins” to use the default margin or  

   “Custom Margins” to use the margin of your choice.  The custom margin cannot be smaller   

  than the default margins. If 2-Booklet is selected in “Pages per Sheet,” “Custom Margins”   

  cannot be selected. 

 -  The custom margins cannot be modified from the document to be printed but can be 

   selected the basic printer setting in the printer & fax folder.

Advanced Tab 

Available functions are “Poster Print,” “WaterMarks,” “Overlays,” “More Options,” and 

“Settings.” Open the basic print setting window to select the advanced tab to change below print 

settings.
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Poster Print

Select Poster Print to print one page into several sheets which form a large output. This function is 

not available for more than One Page on Each Sheet, Booklet, Front Cover, Back Cover, Interleaves 

Pages or Inserted Page (Front/Back Cover). 

Also, if Post Print is selected from the PDL printer driver, only 100% is available for paper scale. 

One page is enlarged into 4, 9, 16 or 25 pages which form a large poster. 

 

Description 

Select the desired page layout (Available layout).

 - Poster 2x2: The document is enlarged into 4 pages.

 - Poster 3x3: The document is enlarged into 9 pages.

 - Poster 4x4: The document is enlarged into 16 pages.

 - Poster 5x5: The document is enlarged into 25 pages.

                                                 

         

Watermarks 

Print the text in the background of the existing document. For example, you can print the text such 

as “Confidential” or “Internal Use Only” on the first page or all pages in a gray and large format. 

The device provides several watermarks by default. 

They can be edited and you can add new watermarks. 



3-27

Scanner, Printer and Fax 

3

Description

Basic Watermark  

 - Select a watermark from the list. Preview is available.

 -  Click OK or Print before exiting the print window.

.

Custom Watermark  

 -  Select Create New in the watermark list.

 -  The new watermark type window appears. Select Text String Watermark or Bitmap Image   

         Watermark.

 - Text String Watermark: Type in your text in the message box. Preview is available. Also, you   

         can select Bold, Italic, Print Outline Only, Size, Angle, Contrast, and Offset Starting Point. 
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 -  Bitmap Image Watermark: You create a bitmap image watermark. You can decide the 

   watermark name and control its scale. Available Offset Starting Points are Center of Page,   

  Tiled, Top Left Corner, Center of Top Edge, Top Right Corner, Center of Right Edge, Bottom 

  Right Corner, Center of Bottom Edge, Bottom Left Corner, Center of Left Edge and Scale to   

  Pges.

 -  Click Add to add a new watermark to the watermark list.

 -  Click OK or Print before exiting the print screen.
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Watermark Editing

 -  Click Edit in the “Available Watermarks” list. The Edit Watermark screen appears. 

   (See the watermark list screen.)

 -  Select a desired watermark from the watermark list and modify the message and options.

 -  Click Change to save changes.

 -  Click OK or Print before exiting the print screen.

Watermark Deletion

 -  Select a desired watermark and click Delete from the watermark list. 

   (See the watermark list screen.)       

 -  Click OK or Print before exiting the print screen.

Usage

     

 -  All Pages: Apply the existing or newly-created watermark to all pages.

 -  First Page Only: Apply the existing or newly-created watermark to the first page only.

 -  First Page / Other Pages: Apply the existing or newly-created watermark to the first page and  

   other pages respectively.

 -  Odd Page / Even Page: Apply the existing or newly-created watermark to odd pages and   

   even pages respectively.
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Overlays

You can print a non-transparent message in the background. In general, the template is used to 

use the overlays. Instead of existing templates, you can create the same overlays as them. Instead 

of loading templates, use the overlays. 

 Create New Overlay: Create a new overlay to use it.

 -  Open a file to be used as the overlay (document to be overlaid).

 -  Open the basic print setting screen to change print settings from the application.

 -  Click the Advanced tab to select Overlays, and then select an item from the list. 

 -  Click Overlay to select Create New Overlay. 

 

 - Select Store to decide the store location and press the print button. 
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 -  Overlays Directory: 

   (Ex: To save the overlays on the drive C, type in “C:\”. A new overlay will be created on C:\.)

 - Click OK to open Create Overlays window. Type in description in the Description field. 

  Check the overlay file and then click OK. 

  (In the below example, the file name is 005AD859.OVL.)

 -  Print the document with the overlay. 

 -  The overlay is printed on the specified location
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Overlay Use

 -  Open the file where the overlay will be applied.

 -  Open the overlay function to see the created overlay.

 -  Select an overlay and click OK. You can see the attribute and location of the overlay and 

   delete the overlay. If there are two or more overlays, you can select different overlays for each  

  page.

 - Click OK or Print before exiting the print screen.

More Options 

You can open the window for additional options: Fonts for the PDL driver, PostScript … for the 

PostScript driver, Mirror Image for the image driver, and Reduce Spool Size for the image driver.

      

                  (SINDOH M402 Series)                             (SINDOH M402 Series PS/PCL5e/PCL6)
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Description

Reduce Spool Size : The spool size of the image driver is compressed. 

Mirror Image: You can make a print of the mirror image.

Settings

You can save current settings, restore previous settings, or reset to the default settings.  

Print Quality Tab

Available options are “Resolution,” “Print Text Black,” “Screening”(Only for SINDOH M402 Series), 

“Halftoning” (Only for SINDOH M402 Series PCL5e), “Grey Correction,”(Not available for PS and 

PCL6) “Toner Darkness,” and “Toner Save.” To change below print settings, open the basic print 

setting window and click the print quality tab.

        

                  (SINDOH M402 Series)                               (SINDOH M402 Series PS/PCL5e/PCL6)
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Resolution

You can select a different resolution in DPI or dpi for the print job. High resolution provides better 

print quality but takes longer time to complete the print job. If the “Out of Memory” error occurs, you 

have to select lower resolution. Available options are 600dpi, 1200dpi, and Photo 1200dpi. 

           

 

 

Print Text Black

Regardless of color selected in the application, you can print non-white texts in black. 

Screening

Available options are “Periodic” or “Error Diffusion.” 

Available only for SINDOH M402 Series device drivers.

 

Halftoning

When half tone is selected, Standard, Rough, Line Art or None can be selected.

Available only for SINDOH M402 Series PCL5e device drivers.
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Grey Correction

You can control contrast and brightness. Default brightness is 0 and default contrast is 2. 

Not available for SINDOH M402 Series PS/PCL6.

Toner Darkness 

You can adjust toner contrast level. 

Toner Save 

You can reduce toner used for printing. 
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7. Print with the USB Memory 

  Preparation for Print with the USB Memory

1 Insert the USB memory to the device.

                                                                                          

   

                      

2 Press the 【Menu】 button. 

3 Press the 【◀】 or 【▶】 button until [USB Memory Print] appears, and then press the 【OK】 button.

4 The LCD shows printable files or folders on the USB memory. 

5  When the file to be printed appears, press the 【 】 button.

6 Printing starts. 

  Note

  - Press the 【OK】 button to enter the subfolder when its root folder appears on the LCD.

  - Comatible files are JPG, BMP and GIF. 

  - Some image files may not be supported depending on their compression type.
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8. Basic Fax  

Default Setting Change

1 Press the 【Fax】 button to the left of the LCD. Then “Std Enter No.” appears on the LCD.

2  To change the transmission mode, press the 【◀】 or 【▶】 button to go to [Tx Mode], and then 

press the 【OK】 button. Here, Memory Tx, Broadcast Tx, Delay Tx and Polling Tx can be 

 selected. For more information, see the advanced fax function.

3  To change resolution, press the 【◀】 or 【▶】 button to go to [Resolution], and then press the 

【OK】 button. 

 -  Press the 【◀】 or 【▶】 button to select desired resolution, and then press the 【OK】 button.

4  To change the image type, press the 【◀】 or 【▶】 button to go to [Image Type], and then press 

the 【OK】 button.

 -  Press the 【◀】 or 【▶】 button to select the desired image type, and then press the 【OK】 

   button.

Basic Operation

1  Place the document on the flatbed or ADF. 

 For more information, see 「Original Placing」 (P. 1-24). Be sure to check if there is any 

 document in the ADF before placing the document on the flatbed.

2 Press the 【Fax】 button on the control panel to switch to the fax mode.

3  Select options if necessary. 

Basic Fax (P. 3-37) 

Advanced Fax (P. 3-40) 

4 Enter the receiver’s fax number. 

Number Pad (for direct input) 

 
 -  Use the number pad to enter the fax number, and then press the 【 】 button.

 -  You can enter up to 40 digits.

 -  If a wrong number is entered, press the 【◀】 button to remove the number one by one. 

   Press the 【 】 button to delete all numbers.
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 -  Press the 【 】 button to enter the pause key. 

Speed Dial 

 ①  【Speed Dial】 button

 -  When Ready is displayed on the LCD, press the 【Speed Dial】 button.

 -  Use the number pad to enter the speed dial number or press the 【◀】 or 【▶】 button to select  

   the registered speed dial number, and then press the 【OK】 button. You may not need to   

   press the 【OK】 button. To enter the speed dial number, enter two digits (01~99).

 -  Press the 【 】 button to send the fax.

 ②  【Fax】 button to the left of the LCD

 -  Press the 【Speed Dial】 button to enter the speed dial number registered to the device, and   

   then press the 【OK】 button. You may not need to press the 【OK】 button.

 -  Press the 【 】 button to send the fax.

Address book 

 -  Press the 【Fax】 button to the left of the LCD. And then press the 【#】 button twice to go to   

   the address book.

 -  Press the 【◀】 or 【▶】 button to select the desired number from the address book, and then   

   press the 【OK】 button. You may not need to press the 【OK】 button.

 -  Press the   button to send the fax.

  Only in [Menu], the telephone number can be added, deleted or modified.

Group dial

 -  Press the 【FAX】 button to the left of the LCD. And then press the 【#】 button once to go to   

   the group dial.

 -  Press the 【◀】 or 【▶】 button to select the desired number from the address book, and then   

   press the 【OK】 button. You may not need to press the 【OK】 button.

 -  Press the   【 】 button to send the fax.

  Only in [Menu], the telephone number can be added, deleted or modified.

[Pause Key] 

 -  When the internal line is switched to the external line, Pause Key gives time to the 

   switchboard. 

   When “Pause” is entered with the 【 】, two-second pause is given when dialing the receiver.

 -  Press the 【 】 button to enter “Pause”. (* appear on the LCD.)
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5 Scan the document for fax.

 If [Tx/Rx Reports] is [ON], transfer results are reported according to [Setting]. 

If [TCR Reports] is [ON], transfer/reception results are reported according to [Setting]. 
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9. Advanced Fax 

Broadcast Tx

You can fax the same document up to 99 receivers.  

1 Place the document on the flatbed or ADF. 

 Be sure to check if there is any document in the ADF before placing the document on the 

 flatbed.

2 Press the 【Fax】 button on the control panel to switch to the fax mode.

3  Select options if necessary.

Basic Fax (P. 3-37)

4 Select Broadcast Tx.

 ①  Press the 【Fax】 button to the left of the LCD to go to the fax mode, and then press the 

 【◀】or【▶】 button until [Tx Mode] appears. Press the 【OK】 button.

 ② Press the 【◀】or【▶】button until [Broadcast Tx] appears.

 ③ Press the 【OK】 button to turn on the function.

5  Press the receiver’s number, and then press the 【OK】 button to add other numbers.  

      Caution

  - Press the 【OK】 button after entering the last number to add the number.

Number Pad (Direct Input)

 -  You can enter up to 40 digits.

 -  If a wrong number is entered, press the 【◀】 button to remove the number one by one.

 -  Press the 【 】 button to delete the current number.

 -  Press the 【 】 button to add the “Pause” key.

Speed Dial

 ①  【Speed Dial】 button

      -  Use the number pad to enter the speed dial number or press the 【◀】 or 【▶】 button to select 

the registered [Speed Dial], and then press the 【OK】 button. To enter the speed dial number, 

enter two digits (01~99).
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 ② Address Book  

      - Press the 【#】 button twice to go to the address book.

 -  Press the 【◀】 or 【▶】 button to select the desired number from the address book, and then   

   press the 【OK】 button. Only in [Menu], the telephone number can be added, deleted or 

   modified.

 -  Use above steps to add new fax numbers. Press the 【◀】 or 【▶】 button to see newly entered  

   numbers. 

 

6   Press the 【 】 button to send.

Polling Tx   

Save the document on the memory and then send it when you want to fax. If this function is used, 

the receiver will be charged for the fee. 

1  Place the original. Before switching to the fax mode, press the 【Menu】 to set resolution and 

density.

 ①  Press the 【Fax】button to the left of the LCD to go to the fax mode, and then press the 

 【◀】or【▶】button until [Tx Mode] appears. Press the【OK】 button.

 ② Press the 【◀】 or 【▶】 button until [Polling Tx] appears.

 ③ Press the 【OK】 button to turn on the function.

2  Press the 【 】 button. 

3  Scan the original and save it on the memory. 



Scanner, Printer and Fax 

3-42

Delay Tx

You can send the document at the designated time without sending it instantly. When it becomes 

the designated time, the document saved on the memory is automatically sent.

1  Place the original. Before switching to the fax mode, press the 【Menu】 to set resolution and 

density. 

 ①  Press the 【Fax】 button to the left of the LCD to go to the fax mode, and then press the 

 【◀】or【▶】 button until [Tx Mode] appears. Press the 【OK】 button.

   ②  Press the 【◀】or 【▶】 button until [Delay Tx] appears.

   ③  Press the 【OK】 button to turn on the function. 

2  Use the number pad, speed dial or address book to enter the number, and the press the 【OK】 

button. Enter the number in the same way as Broadcast Tx.

3  Press the 【◀】 or 【▶】 button to go to the field and use the number pad to enter the time.

 The time format is [HH: MM]. If the time is behind the current time, the document is faxed on this  

 day. If the time is ahead of the current time, the document is faxed on the next day. 

 Caution

  - You can designate the time within 24 hours from the current time.

4 Press the 【 】 button. 

5 Scan the original to save it on the memory. When it becomes the designated time, the fax is   

 sent

DLT Tx

You can scan the DLT document to send it. 

All steps are the same as above transmission modes. However, in the last step, press the 【DLT】 

button to the left of the LCD instead of the 【 】 button
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On-Hook Dial

If you call your receiver and then fax the document, use this function. 

1 Place the original on the flatbed or ADF.

2 Press the 【On-Hook】 button to switch to [Off-Hook]. 

 -  A beep sounds from the speaker.

3 Enter the receiver’s number. 

 -  Use the number pad to enter the number directly in case of on-hook dial. Speed dial and 

   address book are not supported.

4 Check the call sound from the receiver. 

 If you dialed a wrong number of there is no response, press the 【On-Hook】,【 】, and 【 】     

 buttons to return to [On-Hook].

5 When the call sound is heard, press the 【 】 button to fax the document.

6 When the document is faxed, the device automatically switches to the [On-Hook] mode.

 -  When this function is used, Broadcast Tx is not available.
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10. Fax from the PC  

With the PC fax driver, you can send a fax from the PC.   

1 Open the document to be faxed with the application.

2 Select [Print] from the [File] menu. 

3 Check if the printer driver installed on the device is selected. 

4 Open the [Printer driver Properties] window to select [Fax], and then click [OK]. 

5 Click [OK] in the [Print] window to open the [Fax Wizard] window. . 

6  Select settings in the [Cover Page], [Recipient] and [Fax Setting] tab of the [Fax Wizard] 

 window. 

 For more information, see the setting table. 

7 Press the [Send] button in the [Fax Wizard] window to send the fax. Data is transferred from PC  

 to MFP, and then sent to the receiver by the MFP. 
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Tab Menu Description

Cover Page Fax with cover 

page

Use the cover or not.  

To You can enter the receiver’s number.

From You can enter the sender’s number.

Subject You can enter the subject of the fax.

Date The date of fax is automatically printed.

Time The time of fax is automatically printed.

Recipient Name, Fax 

Number

You can enter the receiver’s name and number by 

yourself.  

Phonebook You can select the receiver from the phonebook.  

Fax Setting Quality Select Standard, Fine or Superfine.  

Image Type Select Text or Photo.  

ECM Use ECM or not.  

Defaults Reset to the default settings

Preview Preview of fax

Send Press it to send the fax.

Cancel Press it to cancel the fax.
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1. Setting with the Web Image Monitor

The MFP has the built-in web server. You can access the web server to check the device status and 

usage. Also, you can modify, edit e-mail, FTP and fax address books and change settings. Setting 

scan be changed from the control panel, too.

Follow below steps to access the Web Image Monitor.

1 Open the internet browser (IE or others) from your PC.

2 Enter http://Device’s IP address/ to the address field.

3 The web pages appear as shown below.

[Web Image Monitor]
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2. Paper 

Including the tray to be used for print or copy jobs, you can select paper settings. 

  Paper Setting 

1  Press the 【Menu】 button. 

2 Press the  ◀  or ▶  button until [Paper Setting] appears, and then press the 【OK】 button.

3  Press the  ◀  or ▶  button to go to the wanted item, and then press the 【OK】 button.

4  When you make wanted settings, press the 【 】button to go to the [Ready] mode.

  Paper Setting Table

Paper Settings　 　

Tray 1 Size

Tray 1 Type

Tray 2 Size

Tray 2 Type

MPT Size

MPT Type 

Paper Texture

Paper Weight

Default Source 

 

  Note

        - Tray 2 Size and Tray 2 Type are available only when the optional tray is installed. 
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  Detailed Description of Paper Settings

Setting Description Value

Tray N 

Size

Paper size of Tray N 

Note

 - N can be 1 or 2. Tray 2                         

     is available only when the        

     optional tray is installed.

* A4, A5, Short Edge, B5, Letter, Legal, 

Executive, Statement, US Folio, Quatro, G. 

Letter, G. Legal, Custom Size.

Tray N 

Type

Paper type of Tray N

Note

 - N can be 1 or 2. Tray 2                         

     is available only when the        

     optional tray is installed.

* Standard paper, Transparency, Paper Label  

MPT Size Paper size of the MPT * A4, A5, Short Edge, A5 Long Edge, A6, 

B5, B6, Letter, Legal, Executive, Statement, 

US Folio, Quatro, G. Letter, G. Legal, Card 

100x148, Card 148x200,

Card 200x148, Monarch Envelope, Com9 

Envelope,

Com10 Envelope, C5 Envelope, C6 Envelope, 

DL Envelope

MPT Type Paper type of the MPT * Standard Paper, Card Stock, Envelope, 

Transparency, Paper Label, Vinyl Label, Post 

Card  

Paper 

Texture

Paper Texture setting

(Set by paper type)

Smooth, * Normal, Rough (If the toner is not 

properly attached to the paper, select Rough.)  

Paper 

Weight

Paper Weight setting

(Set by paper weight)

Light, * Normal, Heavy (If the toner is not 

properly attached to the paper, select Heavy.)  

Default 

Source

Default source setting * Select the default source from Tray1, Tray2, 

or MPT. 

Tray2 is available only when the optional tray is 

installed. Trays with the same paper size and 

type are automatically linked. To unlink them, 

change tray settings. 

      (*) is Factory setting 
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3. Copy

You can select the default copy setting. 

The default setting is the setting that you don’t change by pressing the【Copy】 button.

  Setting

1 Press the 【Menu】 button.

2 Press the  ◀  or ▶  button until [Copy Settings] appears, and then press the 【OK】 button.

3  Press the  ◀  or ▶  button to go to the wanted item, and then press the 【OK】 button. 

 Each menu item has a list of various values which consist of descriptive words, number or On/Off.

4  When you make wanted settings, press the 【 】 button to go to the [Ready] mode. 

The default setting is used until you save new settings, or when you reset the copy setting. 

Set settings to your needs. 

  Copy Setting Table  

Copy Settings 　

No. of Copies 

Original Size 

Paper Size 

Paper Source 

Contents 

Darkness 

Brightness 

Contrast 

Background Remove 

Scale 

Copy Type 

Duplex

Collate 
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  Detailed Description of Copy Settings 

Setting Description Value

No. of Copies Set the number of copies. 1~99, * 1 

Original Size Set the Size of the original 

document.

*  A4, A5 SEF, A5 LEF, B5, *Letter, 

Legal, Executive, US Folio  

Paper Size Set the size of paper to be 

used for copy.

Paper Source is Tray 1 or Tray 2: 

    as tray size, A4, A5 SEF, A5 LEF, B5,    

*Letter, Legal, Executive, Statement,      

US Folio, Quatro, G.Letter, G.Legal 

Paper Source is MPT: 

   A4, A5 SEF, A5 LEF, B5, B6, *Letter, 

Legal, Executive, Statement,US Folio, 

Quatro, G.Letter, G.Legal, Card 

100x148, Card 148x200, Card 200x148, 

Monarch Envelope, Com9 Envelope, 

Com10 Envelope, C5 Envelope, C6 

Envelope, DL Envelope

Note

  - [Paper Size] appears only when      

[Paper Source] is Tray 1, Tray 2 or      

      MPT. 

  - Tray 2 is available only when the          

optional tray is installed. 

Paper Source Set the paper source * Auto Size Match, Tray 1, Tray 2, MPT 

Note

 - Tray 2 is available only when the                            

optional tray is installed.

Contents Set the contents of the 

original 

Text, * Text/Photo, Photo  

Darkness Set the darkness of the copy 1~10, * 6  

Brightness Set the brightness of the 

copy

-4~4, * 0  

Contrast Set the contrast of the copy -2~2, * 0  
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Setting Description Value

Background 

Remove

Level of background removal -4~4, * 0

Note

 -  If there is a black image on the edge 

of the original, the overall copy can 

be brighter. In this case, select - 

value to have brightness similar to 

that of the original document.   

Scale Scale of the copy * Auto Scale, 50~200  

Copy Type ID or combined copy * Normal, ID Copy, 2-up, 4-up  

Duplex Print both sides of paper * Off, Short Edge Feed, Long Edge Feed

Collate Set collate or not. Off,* On 

      (*) is Factory setting .
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4. Scan

You can select the default scan setting when you do the scan job with the USB memory. 

The default setting is the setting that you don’t change by pressing the【Scan】button.

When you do the scan job with the PC, settings are subject to the scan driver. 

  Setting  

1  Press the 【Menu】 button.

2 Press the  ◀  or ▶  button until [Scan Settings] appears, and then press the 【OK】 button. 

3 Press the  ◀  or ▶  button to go to the wanted item, and then press the 【OK】 button. 

 Each menu item has a list of various values which consist of descriptive words, number or 

 On/Off. 

4 When you make wanted settings, press the 【 】 button to go to the [Ready] mode. 

 The default setting is used until you save new settings, or when you reset the scan setting. 

 Change settings to your environments. 

  Scan Setting Table 

Scan Settings　 　

Where to scan

Original Size 

Color 

Resolution 

File Format 

JPEG Quality 

Brightness 

Contrast
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  Detailed Description of Scan Settings 

Setting Description Value

Where to scan Location where the scanned 

image is saved

*Scan to USB, Scan to Email, Scan to FTP

Original Size Size of the original document A4, A5 SEF, A5 LEF, B5, *Letter, Legal, 

Executive, US Folio  

Color Color of the original image Color, * Gray, B/W Text, B/W Photo  

Resolution Resolution of the original 

image

75x75dpi, 100x100dpi, 150X150dpi, 

200X200dpi, * 300x300dpi, 600x600dpi  

File Format
File format of the scanned 

image

* PDF, JPG, TIFF  

JPEG Quality Set the quality of JPEG files. * Low, Mid, High  

Brightness
Brightness of the original 

image

Contrast
Contrast of the original 

image

-2~2, * 0 

       (*) is Factory setting 
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5. Print Settings

When you want to print from your PC, you can change the print settings.

  Setting   

1  Press the 【Menu】 button. 

2 Press the  ◀  or ▶  button until [Settings] appears, and then press the 【OK】 button. 

3 Press the  ◀  or ▶  button until [Print Settings] appears, and then press the 【OK】 button. 

4  Press the  ◀  or ▶  button to go to the wanted item, and then press the 【OK】 button. 

 Each menu item has a list of various values which consist of descriptive words, number or 

 On/Off

5   When you make wanted settings, press the 【 】 button to go to the [Ready] mode.

 The default setting is used until you save new settings, or when you reset the printer setting.    

 Change the settings according to your environments. 

  Print Settings Table   

Print Settings 　

Darkness 

Print Timeout 

Setting Priority 

  Detailed Description of Print Settings   

Setting Description Value

Darkness Print darkness 1~10, * 6 

Print Timeout Standby time until print 

cancel (Seconds)

0, 20~255, * 180 (0 means “Not Used”.)  

Setting Priority Priority is given to the printer 

setting or driver setting.

Printer, * Driver  

      
      (*) is Factory setting 



4-11

Settings of Each Function

4

6. General Settings

You can change general function settings to control the MFP.

  General Setting Table
   

General Settings　 　

Power Save

Buzzer

Language

Factory Defaults

Setup ReadyMsg

  Detailed Description of General Settings 

Setting Description Value

Power Save Time to enter the Energy Saver 

Mode (Minutes)

0(Disable)~ 240, * 3 (0 means 

“Not Used”.)   

Buzzer Sound on/off when pressing the 

button

* off, on 

Language Language for the control panel *Korean, English

Factory Defaults Reset to factory settings *No, Yes  

Setup ReadMsg Value for the standby screen None, * Simple, Detail

      (*) is Factory setting 

  Reset to Factory Settings 

To reset the current settings to the factory default settings, select the factory setting menu from the 

general setting menu, and follow the steps described below: .

1  Press the 【Menu】 button. 

2 Press the  ◀  or ▶  button until [Settings] appears, and then press the 【OK】 button. 

3 Press the  ◀  or ▶  button until [General Settings] appears, and then press the 【OK】 button. 
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4  Press the  ◀  or ▶  button until [Factory Defaults] appears, and then press the 【OK】 button. 

5   [Are you sure? Yes/No?] is displayed on the LCD. 

6 Press the 【OK】 button to reset all settings.

      -  [Reinitialize… Do not touch] appears. Then the device restarts.

  Be aware that all settings are restored to factory settings. 

7   To cancel, press the 【 】 button. 

  System Report Printing 

The [System Reports] shows menus, current options, cartridges and current device settings (custom 

settings). With this report, the user can see device settings. 

1  Press the 【Menu】 button. 

2 Press the  ◀  or ▶  button until [Reports] appears, and then press the 【OK】 button. 

3 Press the  ◀  or ▶  button until [System Reports] appears, and then press the 【OK】 button. 

      - “Printing” appears while the report is being printed. 

   When the report is printed, the device is switched to the [Ready] mode. 

  Network Report Printing

The [Network Report] shows network settings and relevant information.

With this report, the user can see network settings.

1 Press the 【Menu】 button. 

2 Press the  ◀  or ▶  button until [Reports] appears, and then press the 【OK】 button.

3 Press the  ◀  or ▶  button until [Network Report] appears, and then press the 【OK】 button.

      - “Printing” appears while the report is being printed. 

   When the report is printed, the device is switched to the [Ready] mode. 

  Error Log and Sample Page Printing 

The [Print Error Log] shows the history of errors. Up to most recent 20 errors are displayed.

You can print the [Sample Page] to test printer performance.
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1   Press the 【Menu】 button. 

2 Press the  ◀  or ▶  button until [Reports] appears, and then press the 【OK】 button

3  Press the  ◀  or ▶  button until [Print Error Log] or [Sample Page] appears, and then press 

 the 【OK】 button. 

      -  “Printing” appears while the report is being printed. 

   When the report is printed, the device is switched to the [Ready] mode. 

  Fax TCR Report Printing  

The [Memory File List] shows documents standing by on the memory.  

1  Press the 【Menu】 button. 

2 Press the  ◀  or ▶  button until [Reports] appears, and then press the 【OK】 button. 

3 Press the  ◀  or ▶  button until [Fax TCR Report] appears, and then press the 【OK】 button.

      -  “Printing” appears while the report is being printed. 

   When the report is printed, the device is switched to the [Ready] mode.

  Fax Tx/Rx Report Printing  

The [Memory File List] shows documents standing by on the memory 

1 Press the 【Menu】 button. 

2 Press the  ◀  or ▶  button until [Reports] appears, and then press the 【OK】 button.

3 Press the  ◀  or ▶  button until [Fax Tx/Rx Report] appears, and then press the 【OK】 button. 

      - “Printing” appears while the report is being printed. 

   When the report is printed, the device is switched to the [Ready] mode.

  Memory File List Printing 

The [Memory File List] shows documents standing by on the memory. 

1  Press the 【Menu】 button. 

2 Press the  ◀  or ▶  button until [Reports] appears, and then press the 【OK】 button.
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3 Press the 【◀】 or 【▶】 button until [Memory File List] appears, and then press the 【OK】 button. 

      -   “Printing” appears while the report is being printed. 

    When the report is printed, the device is switched to the [Ready] mode.

  Reports Table

Reports 

System Report 

Network Report

Fax Address Book

Fax TCR Report

Fax Tx/Rx Report

Memory File List

Print Error Log 

Sample Page 
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7. Fax  

You can change fax settings to send or receive faxes

  Setting

1 Press the 【Menu】 button

2 Press the  ◀  or ▶  button until [Fax Settings] appears, and then press the 【OK】 button 

3  Press the  ◀  or ▶  button to go to the wanted item, and then press the 【OK】 button. 

 Each menu item has a list of various values which consist of descriptive words, number or On/Off.   

4  When you make wanted settings, press the 【 】 button to go to the [Ready] mode. 

 The default setting is used until you save new settings, or when you reset the fax setting.   

 Change settings to your environments. 

 

  Fax Settings Table

Fax Settings 

Generals 

Pending Fax Job 

Speed Dial 

Address Book 

Group Dial

Tx Settings 

Rx Settings 

All Clear Mem

Fax Report Setup 

  Detailed Description of Generals

When power is on, you can set fax settings. 
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  General Table 

Generals 　

Station ID

Station Number

Date/Time

ECM

Line Monitor

Volume 

Station ID

1  Go to [Menu]  [Settings]  [Fax Settings]  [Generals]  [Station ID]. 

2 Use the number pad to enter the station ID.

      - The saved station IDs are displayed in the menu.

 Reference

  - Character input with the number pad.

3 Press the 【OK】 button to save the station ID that you entered.      

      - You can enter up to 40 characters or digits. 

 -  If a wrong number is entered, press the 【◀】 button to remove the number one by one.

   Press the 【 】 button to delete all numbers.

 -  Press the 【▶】 button for spacing.

 

Station Number

1  Go to [Menu]  [Settings]  [Fax Settings]  [Generals]  [Station Number] .

2 Use the number pad to enter the station number .

      - The saved station numbers are displayed in the menu.

3 Press the 【OK】 button to save the station number that you entered.

      - You can enter up to 40 digits

      - If a wrong number is entered, press the 【◀】 button to remove the number one by one.

   Press the 【 】 button to delete all numbers.
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Date/Time

1  Go to [Menu]   [Settings]  [Fax Settings]  [Generals]  [Date/Time].

2 Use the ◀  or ▶  button to go to the field, and then enter the date/time.  

3 Press the 【OK】 button to save the date/time you entered.

      - Time is saved in the format of 24:00. 

ECM  

ECM setting

You can send or receive the fax more clearly with “error correction”. However, the ECM should be 

supported by the other side’s device.  

1  Go to [Menu]  [Settings]  [Fax Settings]  [Fax Tx Setting]  [ECM].

2 Press the ◀  or ▶   button to set “ECM”.

3 Press the [OK] button to save the ECM setting.

Line Monitor 

You can monitor the communication line. When this option is set, you can hear the line tone from 

the speaker.

1  Go to [Menu]  [Settings]  [Fax Settings]  [Generals]  [Line Monitor]. 

2 Press the ◀  or ▶  button to set [Line Monitor]. (Default: On Till Connect)

3 Press the 【OK】 button to apply Line Monitor function.

OFF No sound from the speaker when the fax is received or sent  

On till Connect → 

Default Setting

Sound from the speaker when the fax is received or sent except the 

connection part  

Always On Sound from the speaker throughout fax reception/transfer 
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Volume

You can set speaker volume.

1  Go to [Menu]  [Settings]  [Fax Settings]  [Generals]  [Volume]. 

2 Press the 【◀】 or 【▶】 button to set volume.

3 Press the 【OK】 button to apply the selected volume level.

Value 0 1 2 3 4 5 6 7

Volume                 Low ← Default → High

  Detailed Description of Pending Fax Jobs 

Delay Fax, Broadcast Fax, and Polling Fax can be viewed and canceled. 

1  Go to [Menu]  [Settings]  [Fax Settings]  [Pending Fax Job].

 - The list shows the receiver’s number and fax type. 

Pending Fax Job

(Receipt)

Pending Fax Job 

(Memory Tx)

Pending Fax Job

(Delay Tx) 

Pending Fax Job

(Polling Tx)      

Pending Fax Job

(Forward)

Rx

(12345678)

Mem

(123456789)

Del

(123456789)      

Pol

(123456789)

Fwd

(123456789)

2  Press the 【◀】 or 【▶】 button to select a fax job that you want to cancel, and then press the 

【OK】 button. You will be asked if you really want to cancel the fax job. If the answer is yes, 

press [1]. If not, press [2].  

  Speed Dial Saving and Editing 

1  Go to [Menu]  [Settings]  [Fax Settings]  [Speed Dial]. 

2  When saved speed dial numbers and fax numbers appear, press the 【◀】 or 【▶】 button to 

search for speed dial numbers.  

3 Press the 【OK】 button to enter new speed dial numbers.
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  Address Book 

Press [#] twice or  Go to [Menu]  [Settings]  [Fax Settings]  [Address Book]. 

Receivers name is displayed.

(Addr) NAME           

      [SD Num] 12345678           

Receiver’s Number Saving and Editing 

1  Go to [Menu]  [Settings]  [Fax Settings]  [Address Book]. 

2  Press the 【OK】 button to enter the address. Up to two digits are allowed for the speed dial 

number. Up to 40 characters are allowed for the fax number and address.

 

Alphanumeric Pad

      Use the alphanumeric pad to enter alphabet. 

      In the alphabet mode, each time you press the key, the alphabet and number are displayed 

      one by one. For example, every time the  【1】 key is pressed, displayed are 1   @      every       

      time, the 【2】 key is pressed, displayed are  2  A  B  C  a  b  c. 

Key Description

1 1  @  

2 2  A  B  C  a  b  c 

3 3  D  E  F  d  e  f 

4 4  G  H  I  g  h  i

5 5  J  K  L  j  k  l

6 6  M  N  O  m  n  o

7 7  P  Q  R  S  p  q  r  s

8 8  T  U  V  t  u  v  

9 9  W  X  Y  Z  w  x  y  z
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 Detailed Description of Group Dial 

Several telephone numbers can be grouped and saved. You send the fax to all telephone numbers 

saved in the group.

Press the 【#】 button to use the group dial. To edit the group dial number, go to [Menu]  [Settings] 

 [Fax Settings]  [Group Dial].

1  Press the  ◀  or ▶  button until the desired number appears.

 Available numbers are 1 - 9.

2 Press the 【OK】 button select the group.

3 Enter the group name and press the 【OK】 button.

4 Decide if you want to register the existing number to the seed dial number or enter a new 

 telephone number.

5 Enter the number and then press the 【OK】 button.

6  Decide to add the new number. To end entering the new number, press the 1 key, and to add 

the new number, press the 2 key.

  Detailed Description of Tx Settings

Tx Settings Table

Tx Settings

Original Size

Resolution

Image Type

TTI

Lighter / Darker

Dial Prefix

Auto. Redial

Confidential Tx

Memory FB timeout 

Onhook FB timeout
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Original Size 

1  Go to [Menu]  [Settings]  [Fax Settings]  [Tx Settings]  [Original Size].

2 Press the  ◀  or ▶  button to select the original size. 

3  Press the 【OK】 button to apply the paper size setting. Available paper is: 

 A4, Letter (Default), Legal, A3

Resolution

1  Go to [Menu]  [Settings]  [Fax Settings]  [Tx Settings]  [Resolution].

2 Press the  ◀  or ▶  button to set resolution.

3  Press the 【OK】 button to apply the resolution setting.

Standard→ Default Original with standard texts 

Fine Original with fine texts such as newspaper 

Superfine Original with superfine texts or exquisite pictures such as 

dictionary

Image Type 

1  Go to [Menu]  [Settings]  [Fax Settings]  [Tx Settings]  [Image Type].

2 Press the  ◀  or ▶  button to set the type. 

3 Press the【OK】button to apply the type setting.

Text → Default  Document with general texts 

 Fast. Only black and white images are sent.

Photo  Document with exquisite photos 

 Very slow. Contrast in the document is sent.
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Lighter/Darker 

1  Go to [Menu] [Settings]  [Fax Settings]  [Tx Settings]  [Lighter/Darker].

2 Press the  ◀  or ▶  button to set density.

3 Press the OK   button to apply the density setting.

      - Select one out of five levels to your original.

Value Lightest Lighter Normal Darker Darkest

Density Light ←  Default  → Dark

Dial Prefix 

Dial Prefix setting

1  Go to [Menu]  [Settings]  [Fax Settings]  [Tx Settings]  [Dial Prefix].

2 Press the  ◀  or ▶  button to set the dial prefix. 

      - If [Always On] or [Automatic] is selected, you have to set the number for the dial prefix. 

  For more information, see the dial prefix number.

      - The dial prefix can have up to five digits. 

3 Press the OK   button to save the dial prefix setting.

OFF → Default  No dial prefix.

Automatic  Check if the number is longer than five digits. 

   Longer than 5 digits: Automatically prefixed. 

   Less than 5 digits: No prefix.  .

Always On  Always prefixed.

Dial Prefix Number 

1  Go to [Menu]  [Settings]  [Fax Settings]  [Tx Settings]  [Dial Prefix]  [Always On].

 After Press the OK   button, [Enter Prefix]massage appears on LCD.

2 Use the number pad to enter the prefix number.

      - The dial prefix can have up to five digits. 

3 Press the OK   button to save the dial prefix number entry.
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Auto. Redial 

Number of Auto Redial  

Up to the given number, the device can retry to send the fax if it is not sent properly because the 

receiver’s fax was busy or had any problems.

1  Go to [Menu]  [Settings]  [Fax Settings]  [Tx Settings]  [Auto. Redial]  [No. of Retry].

2 Press the  ◀  or ▶  button to select the number of redial.

      - For the number of redial, 0-5 are available. The default value is 2.

3 Press the  OK  button to save the number or redial.

Interval of Auto Redial 

You can set the interval of auto redial. 

1  Go to [Menu]  [Settings]  [Fax Settings]  [Tx Settings]  [Auto. Redial]  [Retry interval]. 

2 Press the  ◀  or ▶  button to select the interval of redial.

      - For the interval of redial, 1-5 (minutes) are available. The default value is 2.

3 Press the  OK  button to save the interval of redial.

TTI

You can decide whether or not to add your name and fax number on the top of the fax.

1  Go to [Menu]  [Settings]  [Fax Settings]  [Generals]  [TTI]. 

2 Press the  ◀  or ▶  button to set TTI. (Default: On)

3 Press the  OK  button to apply TTI. 

TTI includes:   

[Date:YYYY-MM-DD][Time:HH:mm][Station ID][Station Number][Page: N(current) of M(total)] 

Time is printed in the format of 24:00. For on-hook transmission, page information is displayed in 

the format of [Page: N(current)].
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Confidential Tx 

If this function is used, only the one who knows the password can print the fax on the receivers 

side. 

1  Go to [Menu]   [Settings]   [Fax Settings]   [Tx Settings]   [Confidential Tx].

2 Press the  ◀  or ▶  button to set the confidential Tx

3 Press the OK  button to save the setting.

      - When it is [ON], enter the password. 

  Use the number pad to enter the 4-digit password, and then press the OK  button. 

Memory FB Timeout 

When you send Memory FB Faxes, you can set time to allow a next document to be placed on FB

1  Go to [Menu]   [Settings]   [Fax Settings]   [Tx Settings]   [Memory FB Timeout]. 

2 Press the  ◀  or ▶  button to set the Memory FB Timeout. Default value is 30. (1 ~ 120).

3 Press the OK  button to save the setting.

 Use the number pad to enter time, and then press the OK  button. 

Onhook FB Timeout

When you send Onhook FB Faxes, you can set time to allow a next document to be placed on FB

1  Go to [Menu]   [Settings]   [Fax Settings]   [Tx Settings]  [Onhook FB Timeout]. 

2 Press the  ◀  or ▶  button to set the Onhook FB Timeout. Default value is 10. (1 ~ 30)

3 Press the OK   button to save the setting.

 Use the number pad to enter the time, and then press the OK  button. 
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  Rx Settings

Rx Settings
       

Rx Settings 　

Fax Forward 

Confidential Rx 

No. of Rings 

Auto. Reduction 

Fax Forward 

The received fax can be forwarded according to user-selected number and options. This function is 

useful to receive the fax that is sent to your office during holidays at your home.

Fax Forward set

1   Go to [Menu]   [Settings]   [Fax Settings]   [Rx Settings]  [Fax Forward]  [Fax Forward 

set]. 

2 Use the  ◀  or ▶  button to set fax forward. 

3 Press the  OK  button to apply the fax forwarding mode.

OFF→ Default 

Setting

 [Fax Forward] is not used. 

 The received document is automatically printed.  

ON  The received document is forwarded to the user-selected number.  

Fax Forward Number Set

1  Go to [Menu]   [Settings]   [Fax Settings]   [Rx Settings]  [Fax Forward] [On]. If [Fax 

Forward No] massage appears on LCD, use the number pad, speed dial and address book to 

enter the number, and then press the   OK  button.

      - The forward number is maintained until you change it to another number.

Confidential Rx 

If this function is used, the fax can be received only by the one who knows the password.

1  Go to [Menu]   [Settings]   [Fax Settings]   [Rx Settings]  [Confidential Rx]. 
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2 Press the  ◀  or ▶  button to set this function. 

3 Press the OK  button to save the setting.

      -  When Confidential Rx is on, you have to enter the password. 

  Enter the 4-digit password, and then press the OK  button. 

No. Of Rings 
  
You can select the number rings that are used to transfer the fax to the receiver.

1  Go to [Menu]   [Settings]  [Fax Settings]  [Rx Settings]  [No. of Rings].

2 Press the  ◀  or ▶  button to select the number of rings.

3 Press the OK  button to apply the setting.

      - The available number is 1-10. The default value is 4. 

Auto Reduction 

The received document is automatically reduced.

1  Go to [Menu]   [Settings]   [Fax Settings]  [Rx Settings]  [Auto Reduction].

2 Press the  ◀  or ▶  button to turn on or off Auto Reduction. .

3 Press the OK  button to save the setting.

Detailed Description of Reports

Reports Setting Table

Fax Report Setup 　

TCR Report Set

Tx/Rx Report

TCR Report 

You can print the recent communication log. Also, TCR reports can be printed automatically 

according to the specified cycle. 
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TCR Report Setting

You can automatically print the TCR report according to your settings 

1 Go to [Menu]  [Fax Settings]  [FAX Report Setup]  [TCR Report Set].

2 Press the  ◀  or ▶  button to set your settings.

3 Press the  OK  button to apply your settings.

 
      - On: For every 30 Tx/Rx events, the TCR report is printed automatically.

 - Off: The TCR report is not printed automatically.

TCR Report Printing 

You can print the TCR report manually.

1 Go to [Menu]   [Reports]   [Fax TCR Report]

2 Press the  OK  button to print out the communication history report.
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Tx/Rx Reports  

You can print the Tx/Rx report with the number of faxed pages, communication mode and others. 

Manual Printing 

1  Go to [Menu]  [Reports]  [Fax Tx/Rx Reports].

2 Press the OK  button to print out the report.

Automatic Printing 

You can automatically print the Tx/Rx report according to your settings.

1  Go to [Menu]  [Settings]  [FAX Reports Setup]  [Tx/Rx Report].

2 Press the  ◀  or ▶  button to set your settings. 

3 Press the OK  button to apply the setting.

Always ON The report is printed whenever any communication event occurs.  

On Error The report is printed whenever any error occurs.

Only Tx The report is printed whenever any Tx event occurs.  

Only Rx The report is printed whenever any Rx event occurs.

Tx/Rx The report is printed whenever any Tx or Rx event occurs.

OFF The report is not printed automatically.  



4-29

Settings of Each Function

4

8. Network Setting

First, you have to set the IP address for network print and control. With the control panel or SINDOH 

Network Setting Program included on the supplied CD, you can set network settings.

  Network Setting Table

Network Settings

Wired Network

Show IP Address

Show IPv6 Address

Setup IP Address

DHCP

Static

Enter IP Address

Enter Netmask

Enter Gateway

Primary DNS

Secondary DNS

Show HW address

Wifi Network

Show IP Address

Show SSID

Show IPv6 Address

Setup Connection

Setup IP Address

DHCP

Static

Enter IP Address

Enter Netmask

Enter Gateway

Primary DNS

Show HW address

Clear saved SSID



Settings of Each Function 

4-30

Ping Test

Enter IP Address

Setup 

MailServer

for Machine/Me

Server Address

Authentication

Email ID

Secure Connect.

Server Port

Detailed Description of Network Settings

Menu Item Menu Item Purpose Value

Wired Network Show IP Address Check the current IP 

address (IPv4).

000.000.000.000 ~ 

255.255.255.255

Show IPv6 Address Check the current IPv6 

address.

0000:0000:0000:0000:

0000:0000 ~

FFFF:FFFF:FFFF:FFFF:

FFFF:FFFF

Setup IP 

Address

DHCP Allocate the IP address 

automatically.

Static Type in the IP manually.

-> You should set the 

IP address, netmask 

and gateway.

For detailed values, 

contact your network 

administrator.

* For more information,       

see「Network Setting」

  (P. 4-29).

Enter IP Address :

000.000.000.000 ~ 

255.255.255.255

Enter Netmask :

000.000.000.000 ~ 

255.255.255.255

Enter Gateway :

000.000.000.000 ~ 

255.255.255.255

Show HW address Check the unique Mac 

address.

00: 00: 00: 00: 00: 00 

~ FF:FF:FF:FF:FF:FF
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Menu Item Menu Item Purpose Value

Wifi Network Show IP Address Check the current IP 

address (IPv4).

000.000.000.000 ~ 

255.255.255.255

Show SSID Check the currently-

connected wireless AP 

device.

Show IPv6 Address Check the IPv6 address 

of the current device.

0000:0000:0000:0000:

0000:0000 ~

FFFF:FFFF:FFFF:FFFF:

FFFF:FFFF

Setup IP 

Address

DHCP Allocate the IP address 

automatically.

Static Type in the IP manually.

-> You should set the 

IP address, netmask 

and gateway.

For detailed values, 

contact your network 

administrator.

* For more information, 

see 「Network Setting」

 (P. 4-29).

Enter IP Address :

000.000.000.000 ~ 

255.255.255.255

Enter Netmask :

000.000.000.000 ~ 

255.255.255.255

Enter Gateway :

000.000.000.000 ~ 

255.255.255.255

Show HW address Check the unique Mac 

address.

00: 00: 00: 00: 00: 00 

~ FF:FF:FF:FF:FF:FF

Clear saved SSID Disconnect the current-

ly-connected wireless 

AP device.

* This item cannot be 

selected again if the 

user does not attempt 

connection. 

Setup 

MailServer

Server Address Set the e-mail server 

(SMTP).

Contact the e-mail 

server administrator or 

service provider for the 

server address.

Authentication Authentication to the 

SMTP

No authentication, 

password, encrypted 

password
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Menu Item Menu Item Purpose Value

Email ID Enter your ID and 

password to the e-mail 

server.

The address entered 

here can be used for 

receipt.

E-mail ID and

 password

Secure Connect. Designate e-mail 

security access.

SSL is supported.

No Secure. Contact 

the e-mail server 

administrator or service 

provider for SSL/TLS 

access.

Server Port Port number to access 

the e-mail server

Contact the e-mail 

server administrator or 

service provider for the 

port number.

 Note

  - Use the “SINDOH Network Printer Setup” program to set the IPv6 address.
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Wired Network Setting

First, you have to set the IP address for network print and control. The DHCP server automatically 

can allocate or fix the IP. Also, the IP address can be manually set.

 Note

  - Use the “SINDOH Network Printer Setup” program to set the IPv6 address.

Using the control panel 

1 When the device is ready, press the 【Menu】 button.

2 Press the  ◀  or ▶  button until 【settings】 appear, and then press the 【OK】 button.

3 Press the  ◀  or ▶  button to go to 【Network Settings】 -> 【Wired Network】 -> 

 【Setup IP Address】, and then press the 【OK】 button.

4 ① IP Automatic Setting: Select 【DHCP】, and then press the 【OK】 button.

 ② IP Manual Setting: Select 【Static】 to type in the IP address, netmask and gateway, and then  

   press the 【OK】 button.

 Note

  - Use the “SINDOH Network Printer Setup” program to set the IPv6 address..

IP Manual Setting 

 Follow below instructions to enter the IP address.

 ① Press the 【Menu】 button, press the  ◀  or ▶  button to go to 【Network Settings】 -> 

  【Wired Network】 or 【Wifi Network】 -> 【Setup IP Address】, and then select 【Static】.

   

Enter IP Address

0   .    .    .   

 ② In the above screen, use the number pad or  ◀   ▶  buttons.

 ③ Press the 【OK】 button to show the current values and move to the next step.

   

Enter IP Address

010.    .    .   
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 ④ Repeat ② and ③ to enter the 12-digit IP address.

 ⑤ If you want to use the default value,‘0’, press the 【OK】 button.

 ⑥ Enter the last digit of the IP address, and then press the 【OK】 button to save the IP address  

   and go to the upper menu.

 ⑦ To correct the number, press the 【 】 button. You will move back one by one.

 ⑧ To cancel all, press the 【 】 button. You will go to the upper menu. 

 ⑨ For netmask and gateway, follow the same steps..

Network Setting Program

1 Connect the USB cable, and then turn on the device. At this point, the printer must not be   

 connected to the device via the USB cable.

2 Run the SINDOH MFP Network Configuration.

3 In the left window, go to  [TCP/IP -> Wired].

4 For IPv4, select TCP/IPv4; for IPv6, select TCP/IPv6.

5 ① IP Automatic Setting (DHCP): Select [Use Static IP], and then press the 【OK】 button.

 ② IP Manual Setting: Select [Use DHCP IP] to enter network settings, and then press the 【OK】  

   button.
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 Note

  - In the control panel, you can print the network report.

  - If "SINDOH M400 Series Printer Status Monitor" connected via the USB port is running, 

    you cannot use SINDOH MFP Network Configuration.

    If "SINDOH M400 Series Printer Status Monitor" connected via the USB port is showing in  

    your PC tray, close it, and then run SINDOH MFP Network Configuration.

Wireless Network Setting

To set wireless network settings, you have to the Wi-Fi device which is sold separately.

Wireless Network Connection

1 Press the 【Menu】  button.

2 Press the 【◀】 or 【▶】 button until 【settings】 appear, and then press the 【OK】 button.

3 Go to 【Network Settings】 -> 【Wifi Network】 -> 【Setup Connection】.

 In the 【Setup Connection】 menu, press the 【OK】 button to search networks.

4 Available wireless network devices are displayed.

 Select the wireless network AP (SSID), and then press the 【OK】 button.
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 Ex) When the wireless AP (SSID) is “M40x_AP”, it is displayed as follows..

  M40x_AP

 In front of the AP (SSID), the reception level is displayed.

 There are five reception levels.

                         

                                 Lowest         Low         Normal          High        Highest

 Note

  - For stable wireless network connection, if reception is very poor, the AP is not found even  

    if it can be found by other devices.

5 ① If there is no security settings, wireless network setting is complete. 

 ② If the wireless AP has security settings, the wireless network security window appears.

WEP 

Enter the WEP security key for authentication. If a connection is successfully made, wireless   

network setting is complete.

 Note

  - For WEP, the 64-bit or 128-bit WEP encryption key is used.

WPA/WPA2 

Enter the WPA key. If a connection is successfully made, wireless network setting is complete.

 Note

  - Just as the WEP, the WPA uses TKIP (Temporal Key Integrity Protocol) and AES(Advanced  

    Encryption Standard) for data encryption..
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Enterprise WPA/Enterprise WPA2 (Wireless IEEE802.1x&EAP) 

In case of enterprise WPA/enterprise WPA2, for user authentication, you have to enter the user ID 

and password.

See the Wireless Security Password Entering and follow the LCD message to enter the user ID and 

password. If a connection is successfully made, wireless network setting is complete. 

.

Wireless Security Password Entering

 Follow below steps to enter the password to access the wireless AP.

 ① When the password window appears, enter the password to access the wireless AP.

  There are four character groups for your convenience: number (0 ~ 9), lower case (a~z),   

  upper case (A ~ Z), and symbol (@, #, %).

 ② Press the 【 】 button to switch to the character group. The group appears in order of, number  

   -> lower case -> upper case -> symbol ->  “  ”.

 ③ Press number buttons or 【◀】,【▶】 buttons until the desired character or number appears.   

    Every time the number key is pressed, the character appears in order of, lower case ->

  number -> upper case.

   Press the 【◀】 or 【▶】 button to show characters in all character groups one by one.

   If the desired number or character appears, press the 【OK】 button.

   

Password

0   .    .    .   

 ④ Repeat ② and ③ to enter the wireless AP password.

 ⑤ After entering the password, press the 【 】 or 【 】 button to move to the character group.   

   While “  ” is displayed, press the 【OK】 button to access the wireless AP with the SSID..

 ⑥ To cancel input, press the 【 】 button. You will go to the upper menu.  

 Caution

  - For convenience reasons, each password character is displayed. Be careful not to expose  

    the wireless AP password to others..
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IP Address Setting

First, you have to set the IP address for network print and control. The DHCP server automatically 

can allocate or fix the IP. Also, the IP address can be manually set.

 Note

  - Use the “SINDOH MFP Network Configuration” program to set the IPv6 address.

Using the control panel

1 When the device is ready, press the 【Menu】 button. 

2 Press the 【◀】 or 【▶】 button until settings appear, and then press the 【OK】 button.

3 Press the 【◀】 or 【▶】 button to go to Network Settings -> Wireless Network -> Wireless AP   

 Connection, and then press the 【OK】 button.

4 ① IP Automatic Setting: Select automatic settings, and then press the 【OK】 button. 

 ② IP Manual Setting: Select manual settings to type in the IP address, netmask and gateway,   

   and then press the 【OK】 button. 

   To set the IP address manually, see  「IP Manual Setting」 (P. 4-33).

 Note

  - Use the “SINDOH MFP Network Configuration” program to set the IPv6 address.  

Network Setting Program

1 Connect the USB cable, and turn on the device. At this point, the printer must not be    

 connected to the device via the USB cable.

2 Run the network setting program,“SINDOH Network Printer Setup”.

3 In the left window, go to [TCP/IP -> Wireless].

4 For IPv4, select TCP/IPv4; for IPv6, select TCP/IPv6.

5 ① IP Automatic Setting (DHCP): Select [Use Static IP], and then press the 【OK】 button.

 ② IP Manual Setting: Select [Use DHCP IP] to enter network settings, and then press the 【OK】  

   button. 
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 Note

  - In the control panel, you can print the network report.

  - If "SINDOH M400 Series Printer Status Monitor" connected via the USB port is running, you  

    cannot use SINDOH MFP Network Configuration.

    If "SINDOH M400 Series Printer Status Monitor" connected via the USB port is showing in  

    your PC tray, close it, and then run SINDOH MFP Network Configuration.

When the device is shipped from the manu facturer , its default network setting is DHCP. To use the 

fixed IP, contact your network administrator. If the IP address is selected arbitrarily, the device may 

not be connected to the network..
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9. Device Remote Monitor/Control

This device can be remotely monitored and controlled via the network.

Remote monitor/control functions can be used with “Web Image Monitor”, “Device Monitor”, and 

“Email Alert Function”.

 Reference

  - To use Web Image Monitor, see 4-2. Setting with the Web Image Monitor.

  How to Use Device Monitor

Install the Device Monitor on your PC to check device status/counter information.

Device information can be extracted in the CSV format. If there is a change in device status, it is 

displayed on the pop-up window. 

The device monitor program can be installed from the accompanying CD.

Major Functions

Key menus are File, Group, Setting, and View.

Frequently-used functions can be used from the tool bar.    

   

     

    

      

         

  

                    [Device Monitor Screen]
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File Menu

 - Adding device :  Add the device to be monitored. Input the IP.

 - Removing device :  Remove the registered device.

 - Export device list :  Export device information to the CSV file.

 - Exit :  Exit the program.

Group Menu

 - Open Group : Select the group to be displayed.

            The screen displays only devices belonging to the group.

 - Close Group : Close the group window.

 - Group Management : Manage registered devices in group.

           Groups can be added/deleted. Devices in the group can be added/deleted.

Setting Menu

 - Notification Settings : Change in device status can be notified via the pop-up window.

           Default items are: Error Code, Low toner/Ink, No toner/Ink, No Response   

        (default 120 sec), and Changed Device.

 - Devices Search Settings : Devices can be automatically searched for registration.

                 Broadcast or IP band input can selected.

                                          If the IP band is wide, it takes several minutes to find devices.

                                          The default setting is Broadcast.

 - Period Setting :  The update period can be selected.

                 Configuration update (default 60 sec)

                             Counter information update (default 300 sec)

                             Toner information update (default 300 sec)

                             Timeout (default 3 sec)

View Menu

 - Refresh :  Device information on the screen is updated.

 - Column Settings : The type of displayed information can be selected.

                               Select the device and right-click the mouse to show the menu to go to the  

                               web page and register/delete the device.

Key Information

     IP : Device IP. Click it to go to the device’s web page.

     Model Name : Device’s model name
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Connection Time : Time when device information is collected.

Serial Number : Device’s serial number.

Status : Status of printer, copier, scanner, and fax.

Counter : Counter for Overall, Black, Color and functions.

Tool Bar Menu

 Search of devices 

Search devices automatically on the network. It can be selected in Devices Search Settings.

Searched devices can be selected and added.

Adding device

Removing device 

Period Setting

Column Settings

Refresh

 Information

                                                [Device Status on Device Monitor]
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 Auto Email Alert

Administration functions include automatic e-mail alert.

If any change occurs to device status/consumables, it is notified with the registered administrator 

e-mail. 

Items for notification can be selected. 

This function can be set only by Web Image Monitor. 

To use this function, see 4-2. Setting with the Web Image Monitor and log into Web Image Monitor 

to make settings.

For setting menus, as shown in the below figure, go to System Setting -> Network -> Auto Email 

Alert.

                               

                                                     [Auto Email Alert Setting]
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Menu Purpose Setting

Admin Email Address 

Setting

Input the administrator 

e-mail.

Input e-mail addresses of those who will 

receive alert e-mails.

Up to 10 e-mail addresses can be 

registered.

Alert Option Setting Decide whether or not 

to use Auto Email Alert.

Turn on Alert to use this 

function.

On

*Off

Item Select

Toner End

Drum Cartridge Change

Intervention Required

Paper Empty

Paper Jam

Output Full Stack
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1. Maintenance of Consumables 

  Status of Consumables

The LCD shows when consumables need to be replaced. 

In [Reports], print the [System Report] to check the status of consumables. Press the 【Menu】 

button. Press the 【◀】 or 【▶】 button until [Reports] appears, and then press the 【OK】 button. 

Press the 【◀】 or 【▶】 button until [System Report] appears, and then press the 【OK】 button to print 

the system report. Check out “Toner remain life in percent”. 

However, as the remaining life is decided assuming consumables are applied to 5% of whole page, 

if the device is used in abnormal conditions or inappropriate density is used, the remaining life may 

not be correct.
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2. MFP Maintenance 

Remove the cartridge and clean up the MFP to keep it in its optimal conditions. 

For more information, see 「Toner Cartridge Replacement」 (P. 5-6) and 「Cleaning」 (P. 5-15).  

If the MFP is used by several users, designate one responsible for device maintenance

  Saving Consumables  

Save Consumables to reduce printing costs. 

Use settings to save toners and paper. 

Go to [Print Settings] -> [Darkness] to decide toner darkness. 

The available value is 1 (lightest) to 10 (darkest). 

For more information, see 「Print Settings」 (P. 4-10). Toner darkness can be controlled in the 

printer driver, too. 

  Ordering Consumables 

Contact your dealer to order consumables. 

  Cartridge Ordering 

If “Toner Low” is displayed, order a new cartridge. If the output is not clear while “Toner Low” is 

displayed, shake the cartridge. This will make the output a little clearer. However, the cartridge 

should be replaced as soon as possible. 

Available cartridge capacities are 2,500 sheets, 5,000 sheets and 8,000 pages. They are based on 

the average use (5% printing).  

 Caution

   - If you keep using the device after “Toner Low” is displayed without replacing the cartridge,  

    “Toner cartridge Change” is displayed and the device stops. Replace the old cartridge
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  Cartridge Storaging

Keep the cartridge in the packed condition. 

Do not store the cartridge in below conditions:

   40℃(140℉) or higher     Dirty place

   Rapid temperature or humidity change   Direct sunray

   Salty air       Corrosive gas  

   Long time in the car  
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3. Consumables Change  

Replace Consumables when the LCD shows the change message.

   Toner Cartridge 

When the LCD shows “Toner Cartridge Change,” replace the toner cartridge.

 Reference

  - For more information, see 「Toner Cartridge Replacement」 (P. 5-6). 

 

   Drum Cartridge

When the LCD shows “Drum Cartridge Change,” printing will not be possible any more. So change 

the drum cartridge as soon as possible. . 

 Reference

  - For more information, see 「Drum Cartridge Replacement」 (P. 5-9). 
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   Toner Cartridge Replacement 

When the toner runs low, “Toner Low” is displayed on the LCD. 

You may use the device a little longer. But replace the toner cartridge as soon as possible. 

If the device cannot print any more because the toner is completely used, the LCD displays 

“Toner Cartridge Change.” Replace the toner cartridge with a new one. 

 Important

     -    Shake the toner cartridge five to ten times before installing it. 

    Shake it after attaching it to the drum cartridge. 

         -  Dispose the used toner cartridge according to regulations.

 Caution

         -   Do not burn the toner cartridge. 

   You may have burns due to distributed toners.   

         -   Be careful not to have your hand, cloth or device contact the toner. If your hand is  

 stained with toners, wash them away with clean water or soft cleaner.  

         -  If the toner enters your eye, clean your eye and then consult with your doctor.

Replacement

1  Switch off the MFP, and then press the unlock button (①) on its left side to open the front 

cover (②).



5-7

Maintenance and Troubleshooting

5

2 Pull out the cartridge from the device, and then press the toner cartridge removal button (①) to  

 remove the old cartridge (②). Dispose the old cartridge according to regulations. 

                                                                        

                                                                                

          

3  Pull out the new toner cartridge from the box.   

Shake the new toner cartridge to distribute toners evenly within the cartridge.

 

        

 

                                                             

 Warning   Damage Risk

   -  Do not expose the drum cartridge to the direct sunray for a long time.

    Long time exposure to direct sunray may damage photoconductor’s coating film to cause   

    print quality problems. 

Toner Cartridge Removal 

Toner Cartridge
Drum Cartridge
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4 Hold the handles of the toner cartridge, align the white tabs of the toner cartridge to the track   

 (arrow sticker) of the drum cartridge, and then push the toner cartridge into the drum cartridge. 

 The toner cartridge is properly installed into the drum cartridge when you hear a click. 

5 Follow below steps. 

 A. Hold the handle with your palm facing upward. 

 B. Align the front hooks (arrow sticker) of the cartridge to the guides (arrow sticker) of the 

  device. 

 C. Push the cartridge into the device until you hear a click. 
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6 Close the front cover.

 Caution

   - Check if the MPT is closed when closing the front cover. If the front cover is closed with the  

    MPT open, it may cause malfunction. 

   Drum Cartridge Replacement 

MFP displays “Drum Cartridge Change” on the LCD to give a notice before the drum cartridge 

reaches its life. You can print the menu setting page to check the status of the drum cartridge. (If 

you change the drum cartridge before resetting the drum cartridge counter, the menu page may not 

present the status of the drum cartridge correctly.) 

When “Drum Cartridge Change” appears on the LCD first time, you have to replace the drum car-

tridge immediately. 

After the drum cartridge reaches its life, the device can operate for some time but print quality drops 

significantly.

1 Switch off the device. 
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2  Press the unlock button (①) on the left side of the device to open the front cover (②). 

3  Hold the handle (③) to pull out the cartridge. (Be sure to have your palm facing upward.) 

4 Place the cartridge on the level and clean surface

5 Press the toner cartridge removal button (①), and then hold the handle of the toner cartridge  

 (②) to pull out the toner cartridge. 

Toner Cartridge 

Drum Cartridge

Toner Cartridge Removal Button 
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6 Pull out the new drum cartridge from its box, and then remove the protection cover.

7 Hold the handles of the toner cartridge, align the white tabs of the toner cartridge to the track   

 (arrow sticker) of the drum cartridge, and then push the toner cartridge into the drum 

 cartridge. The toner cartridge is properly installed into the drum cartridge when you hear a   

 click. 

 Unpack the new drum cartridge. Do not touch the drum. Do not touch the photoconductor   

 under the drum cartridge. 

8 Follow below steps. 

      
 A. Hold the handle with your palm facing upward.

 B.   Align the front hooks (arrow sticker) of the cartridge to the guides (arrow sticker) of the 

   device

 C. Push the cartridge into the device until you hear a click.
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9 Reset the drum cartridge counter. 

 For more information, see the guide accompanying the new drum cartridge.

 Warning  

   - If you reset the drum cartridge counter without replacing the drum cartridge, the device may  

    be damaged and contaminated, which is not covered by the warranty.

10 Close the front cover. 

 Caution

   - Check if the MPT is closed when closing the front cover. If the front cover is closed with   

    the MPT open, it may cause malfunction. 
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   ADF Pad Replacement 

1 Open the ADF cover.

2 Pull out the original feeder roller and remove it. 

3 Remove the paper removal pad as shown in the picture below.

4 Install a new paper separation pad in the reverse order of removal.
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5 Put one end of the roller into hole A and then put the other end into hole B. 

6 Close the ADF cover. 
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4. Cleaning

You can clean the device. 

Cleaning, maintenance and recycling not described here are allowed only for qualified people.

 Important
        
        -  Do not use benzene, thinner or other cleaning chemicals as they damage plastic parts and  

    paint.  

        -  Do not use paper towels. They may be attached to the inside of the device to cause static   

     electricity. Use soft clothes to protect the device surface. 

   Outer Surface Cleaning                   

Dip the soft cloth into water or soft cleaner, wring it out completely, and then clean the outer 

surface.

   Scanner Area Cleaning                                 

If the scanner area is dirty, unwanted spots or lines are printed. Clean the scanner area regularly.

Clean
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ADF, Flatbed, Flatbed Cover, and Pad Cleaning 

Dip the soft cloth into water or soft cleaner, wring it out completely, and then clean the surface. And 

the clean the surface with the clean dry cloth. If the device is dirty, apply a little amount of alcohol 

to the cloth, clean the device, and then clean the device with the clean and dry cloth. 

ADF Cleaning 

If the ADF is dirty, black lines can be printed on paper. If something is on the roller, jammed paper 

could occur. Clean the roller and pad regularly. 

Dip the soft cloth into water, wring it out completely, and then clean the surface.

Then, clean the surface with the clean dry cloth. 

Spin the roller, and clean it downward. 

ADF Pad Cleaning  

1 Remove the roller from the ADF. 
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2 Dip the soft cloth into water, wring it out completely, and then clean the surface. 

 And clean the surface with the clean dry cloth

 

3 ③ Put one end of the roller into hole A and then put the other end into hole B.  

Clean
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   Printer Area Cleaning   
                                           

For following cases, clean the roller in the printer area. 

Frequent paper jam: Low print quality (Clean the scanner too.) 

Dip the soft cloth into water, wring it out completely, and then clean the surface. 

And the clean the surface with the clean dry cloth. 

Spin the roller, and clean it downward. 

 Caution

  -   The fusing unit and its surrounding areas are very hot while the device is operating. 

    Do not touch the fusing unit and its surrounding areas. It may cause burns. 

 Important
        
         -   Do not expose the drum cartridge to the sunray more than five minutes. 

         -  Do not touch the drum. It may cause print errors.
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5. Understanding of Messages

The LCD of the control panel is designed to display the current status and problems. This section 

describes messages and how to respond them. 

 

Message Description Response

Canceling.. The current is being canceled.  

Re-insert 

Cartridge

No or unsupported cartridge. Reinstall the cartridge. If this 

message appears again, replace 

the cartridge.  

Cover Open The front cover is open. Close the cover.  

Cancel Job? The stop button is pressed while 

printing.

 Press the 【 】 button to cancle 

the job or press the 【 】 button to 

continue the job.    

Code Updating 

Do Not Power Off

The device is being programmed 

with new system code.

Warning

 -  When this message is on, never 

switch off the device.

Ready to copy The device is ready for a copy 

job.

Reinitialize/reboot Factory defaults are being re-

stored.  

Toner Low The toner is low. Shake the toner to use remaining 

toners. 

Replace the cartridge. 

Press the 【 】 button to remove the 

message and continue.  

Reference

 -  If you don’t replace the 

      cartridge, quality problems can      

      occur. Also, the device will   

      stop after printing a few more   

      sheets. 

Toner Cartridge 

Change

The toner cartridge reaches its 

life and should be replaced.

Replace the cartridge with a new 

one.

Paper Empty:T1 There is no paper in the tray 1. Load paper to the tray 1.

Paper Empty:T2 There is no paper in the tray 2. Load paper to the tray 2.
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Message Description Response

Paper Empty:MPT There is no paper in the MPT.. Load paper to the MPT.

101 Paper Jam No paper supplied from the tray 

1

Check if paper is properly loaded in 

the tray 1.

102 Paper Jam No paper supplied from the tray 

2

Check if paper is properly loaded in 

the tray 2.

103 Paper Jam No paper supplied from the MPT Check if paper is properly loaded in 

the MPT.

104 Paper Jam Paper jam inside of the device Open the front cover and pull out 

the cartridge to remove the jammed 

paper.

105 Paper Jam Paper jam inside of the device Open the front cover and pull out 

the cartridge to remove the jammed 

paper.

106 Paper Jam Paper jam in the feeder Open the back over to remove the 

jammed paper from the feeder 

path.

107 Paper Jam Paper jam in the duplex unit Open the duplex unit cover to 

remove paper from the paper path.

Check Paper Size The message tells that the paper 

does not match the printer 

settings.

To fix the problem, load 

appropriate paper to the tray, and 

then press the 【Start】 button. See

「Paper Setting」(P. 4-3) to change 

printer settings. 

Drum cartridge 

change

It is time to replace the drum 

cartridge.

Replace the cartridge with a new 

one, and then reset the drum 

cartridge counter to have the 

message disappear.

Reference

 - If you don’t replace the 

     cartridge, quality problems may         

     occur.  

Insufficient Memory The original exceeds print 

capacity.

Separate the original for printing.  
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Message Description Response

201 Scanner Jam No paper from the ADF. Adjust the document and then 

retry.  

202 Scanner Jam Paper jam in the ADF Remove a jam and retry. 

Insufficient Memory Not enough memory to continue 

the fax, scan or copy job

 If a scan job is initiated from the 

PC, close all applications on your 

PC and retry. 

 If a fax/copy job is being 

   executed, decrease the amount    

   of the document from the ADF.   

USB  Cable

Disconnected

The USB cable is disconnected 

during scanning to the PC.

Check the USB cable is 

connected. If the cable is 

connected, disconnect and 

connect it at both the PC and the 

MFP again.  

USB Not Ready When USB Memory is used, 

access to the USB Drive is not 

available.

 Check if the USB Drive is 

   properly connected. It takes 5 

seconds to recognize the USB 

Drive. So, wait for five seconds 

after installing the USB Drive.

 Some USB Drives may not be 

recognized. Try with a different 

type of USB memory.

File Write Error Fail to write or send scanned 

files if scanning files to USB 

Memory, scanning emails, or 

FTP scanning.

 Scan with the USB memory: 

Connect the USB memory again. 

The USB drive may not have 

enough space.

 E-mail scan:

   Check if the network is correctly 

connected or e-mail server 

   settings are correct..

 FTP Scan:

   Check if the network is correctly 

connected or ID and password to 

the FTP server are correct.



Maintenance and Troubleshooting 

5-22

Message Description Response

Unknown File 

Format

The file on the USB memory is 

not supported for printing when 

using the Print from USB Drive 

function.

 Check if the file is corrupted at 

the PC.

  Some image file compression 

methods are not supported. To 

print a non-supported file, print 

it at your PC.

Err: Enter No. No fax number is entered. Enter the number and retry. 

Fax : No Line The telephone line is not 

connected. 

Connect the telephone line and 

retry.

Fax : Memory rack The fax memory is not enough to 

send or receive the fax.

Delete fax pending jobs from the 

memory.

Finding Available wireless APs are being 

searched.

Wait until available wireless APs are 

found.

Connecting… The connection to the selected 

wireless AP is being made. 

Wait until the connection is made.

Not Found Available wireless APs are not 

found.

Check the wireless AP. If the wire-

less AP is normal, put it closer to 

the device.

Wifi Conn. Fail Fail to the connect the wireless 

AP.

Check the wireless AP. Check if 

you entered the password correctly.

Password Needed Enter the password to the 

wireless AP.

Contact your network administra-

tor for the password to the wireless 

AP.

Wi-Fi Not 

Connected 

No wireless AP is connected. Contact your network administrator 

for wireless connection. For more 

information, see 「Network Setting」

(P. 4-29).

Other Messages 

with a Number

Check if options are properly 

installed. If you are not a printer 

technician, contact the service 

center or dealer.

Warning

 -  3XX messages are critical. Be 

sure to contact the service center  

or printer technician.
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6. Paper Jam Removal          

When jammed paper occurs, its location is displayed on the LCD. 

Follow below instructions to remove the jammed paper. 

After removing the jammed paper, press the【 】button to restart a copy Job. “Jam” 

disappears from the LCD. If the jammed paper cannot be removed, contact one of our dealers. 

   Paper Jam                              

If paper jam occurs in the ADF, “20X Scanner Jam” is displayed on the LCD. 

Follow below steps to remove the jammed paper carefully. 

 Important

   -  Do not use excessive force. If you use excessive force, paper can be torn

1 Open the ADF cover. 
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2  Remove jammed paper. 

 If you cannot remove the jammed paper, go to 3  . 

3 Remove the paper feeder roller by pulling it out.



5-25

Maintenance and Troubleshooting

5

4  Remove the jammed paper slowly. 

 If you can’t remove it, go to 5  .

5 Open the ADF. 
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6 Remove the jammed paper. 

7 If paper is jammed under the ADF tray, pull it out in the arrow direction.
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  Paper Jam Location Indicated by the Error Code

The figure below shows the paper path within the ADF.  

201 Scanner Jam
(Misfeed) 

       202 Scanner Jam       
(Long Paper Jam) 
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7. Paper Jam Removal

If you choose quality paper and load it correctly, most of the paper jams can be prevented. 

If paper jam occurs often, see 「Print Paper Loading」(P. 1-17) and 「Paper」 (P. 4-3). 

 Caution

   -  Remove all paper jams on the paper path. Press the  【 】 button and then printing contin-

ues. Even when jammed paper is removed and the 【 】 button is pressed, if the “10X Paper 

Jam” lamp is on, check the inside of the device. 

  Paper Jam Location Indicated by the Error Code 

The figure below shows the paper path within the device. 

The path may vary according to the tray or MPT, or feeder.

104 Paper Jam

105 Paper Jam  

103 Paper Jam

101 Paper Jam

107 Paper Jam

102 Paper Jam

106 Paper Jam
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  104/105 Paper Jam (Under the Cartridge) 

 Warning

   -  When the cartridge is removed, inside of the device is hot. 

     Do not touch the inside of the device when removing jammed paper. 

 Caution

   -  The back of paper may not be visible. 

Follow below steps if paper jam occurs under the cartridge. 

1 Open the front cover. 

2 Remove the cartridge. See 「Toner Cartridge Replacement」 (P. 5-6).

3 Use both hands to remove jammed paper

 Caution

        -  If it is difficult to pull out the jammed paper, open the feeder cover.

        -  Be careful. The inside of the device is hot. 

    

 Caution

        -  If it is difficult to pull out the jammed paper, open the feeder cover. To remove jammed   

    paper from the back feeder cover, see 「106 Paper Jam」 (P. 5-30).  

        -   If paper jam occurs while paper is supplied from the MPT, remove remaining 

      paper from the MPT, close the MPT cover, and then open the front cover.  

      If the front cover is closed while the MPT open, it may cause malfunction.   

4 Replace the cartridge. See 「Toner Cartridge Replacement」 (P. 5-6). 



Maintenance and Troubleshooting 

5-30

5 Close the front cover. 

 Important

    - If you cannot remove the jammed paper with above steps: 

               A.  The fusing unit may have jammed paper. In this case, follow below steps. 

              (1) Pull down the display unit. 

    (2) While pressing the display unit, remove the jammed paper. 

    (3) Check if the display unit returns to its original position. 

      Caution

        - If you pull down the display unit, the inside of the device is hot. 

     If possible, use the tweezers rather than your hands to remove jammed paper. 

 106 Paper Jam (Back Feeder Cover) 

Open the front cover and the back feeder cover. 

For the jammed paper which does not leave the flatbed, see removal of jammed paper visible from 

the flatbed.

For the jammed paper which does not reach the feeder, see removal of jammed paper invisible from 

the flatbed.

  Removal of The jammed paper Visible From The Flatbed

1 Pull out the jammed paper. 

2 If it is not easy to pull out the jammed paper, see removal of jammed paper invisible from the   

 flatbed.
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  Removal of the jammed paper Invisible From The Flatbed 

1 Open the back feeder cover.  

2 Remove the jammed paper softly according to the degree of exposure of the paper.

 A. If the middle part of paper is visible but its end is not visible, hold its both sides and pull it out. 

 B. If the end of paper is visible, pull it out directly. 
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3 Close the back feeder cover.

 
      - Check both sides are closed.

107 Paper Jam (Under the Device, 2-Sided Paper Jam)

During 2-sided printing, a paper jam can occur under the device and over the tray.

Follow below steps to remove a paper jam.

1 Pull out the tray 1.

2 The handle is under the device..

         

3 Pull down the handle.

4 Search for a paper jam. If it is not seen from the front, go to  6  .

5 Pull out a paper jam.
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6 Lift the handle or the duplex unit to close it.

 Caution

   - Check if both sides of the duplex unit are closed.

7 ⑦ If a paper jam is not seen from the front, open the feeder cover to remove a paper jam. 

  101 Paper Jam (Tray 1) 

1  Pull out the tray 1.  

(Handles to remove the tray are on both sides of the tray.)

 

2 Pull out the jammed paper. 
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3 Push back the tray. 

  102 Paper Jam (Tray 2)

1  Pull out the tray 2.  

(Handles to remove the tray are on both sides of the tray.)

 

2  Pull out the jammed paper. .

 

 

3  Push back the tray.
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  103 Paper Jam (MPT) 

1 Pull out the jammed paper.

      - If paper jamming occurs while paper is supplied from the MFP, remove remaining paper from  

  the MPT, close the MPT cover, and then open the front cover. 

  If the front cover is closed while the MPT open, it may cause malfunction. 

 



Maintenance and Troubleshooting 

5-36

8. Troubleshooting  
             

If a problem occurs, see followings. 

If you can’t resolve the problem with following instructions, contact one of our dealers. 

If you sense unusual sound, smell or smoke from the device, unplug the power cord immediately 

and contact one of our dealers. The problem caused by unauthorized repair, remodel or Consum-

ables may not be covered by the warranty. 

  The Device Does Not Work.          

Status Verification Solution Reference Page

The device does 

not work.

Check if the

power cord is properly 

plugged.

Check the power switch 

and power cord. P. 1-6, 1-11

Check if the power 

switch is on.

Switch on the device.
P. 1-6, 1-11

Nothing on the 

LCD.

Check if the 

power cord is properly 

plugged and power 

switch is on.

Check the power switch 

and plug, and switch on 

the device.
P. 1-6, 1-11

Cannot dial. Check if the telephone 

line is properly con-

nected.

Connect the telephone 

line properly.
P. 1-6

No output paper. Check if there is 

jammed paper.

Check the error message 

and remove the jammed 

paper. 

P. 5-19

Frequent paper 

jam and wrinkled 

paper.

Check if paper is 

properly loaded.

Load paper properly.  
-

Check if paper size is 

correctly set.

Set correct paper size.
P. 2-3, 2-7

Check if proper paper 

is used.

Use paper described in 

this manual.  
P. 2-3

Check if paper is wet. Use dry paper.  
-
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Status Verification Solution Reference Page

No output paper. Check if there is 

jammed paper in the 

ADF.

Remove the jammed 

paper and reload the 

document.

P. 5-15

Frequent document 

jam.

Check if the proper 

document is used.

Use the proper 

document.  
P. 1-29, P. 2-3

Check if the

document guide is 

properly adjusted.

Adjust the guide to 

the document.  -

Check if there is a 

paper segment in the 

ADF.

Open the ADF cover 

and tray.  P. 5-23

Check if the roller is 

clean.

Clean the roller.  
P. 5-15

Cannot close the 

cover.

Check if only one 

side of the cover is 

pressed.

Press the both sides 

of the cover.  -
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 Cannot Send the Fax (Only for the M401)               
  

Status Verification Solution Reference Page

Cannot send the 

fax.

Check if the transmis-

sion method is correct.

Check the transmission 

method and retry.
P. 3-40, 3-41

Check if the receiver’s 

number is correct.

If you use the speed 

dial, print the list and 

check if the number is 

correct.

P. 3-40

Check if the error 

message is displayed.
Take steps related to 

the error message. 
-

Check if the external 

line number is included.

Include the external line 

number if you dial from 

the internal line.
P. 3-40

Check if the receiver’s 

fax has no problem.

Request the receiver to 

have his/her fax ready 

(power, paper).

-

Cannot send the 

document 

continuously.

Check if the document 

is correctly arranged.

Reload the document.

-

Check if there is any 

page of which width is 

smaller than the 

minimum width.

Separately send pages 

of which width is 

smaller than the 

minimum width.

-

Cannot send the 

fax even when you 

dial the number.

Check if the document 

is correctly loaded.

Load the document 

correctly.
-

Check if the receiver’s 

fax has paper.

Request the receiver to 

have his/her fax loaded.
-

Check if the receiver’s 

number is correct.

Dial the correct number.
P. 3-40

Check if the receiver is 

busy.

Until the line become 

available.
-
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Status Verification Solution Reference Page

Cannot send 

the fax 

manually.

Did you press the 【On-

Hook】 button to hear a 

ring tone, and then press 

the 【 】 button?

Press the 【On-Hook】 but-

ton to hear a ring tone, and 

then press the   【 】 button.
P. 3-42

In the memory 

transmission 

mode, cannot 

scan the 

document.

Check if the document is 

correctly loaded.

Load the document 

correctly.
-

Check if the memory is 

enough.

Check the memory.
-

  
Cannot Receive the Fax                     

      

Status Verification Solution Reference Page

Cannot send 

the fax.

Check if the automatic 

transmission mode is set.

Check the transmission 

mode.
P. 4-24

Check if the document is 

correctly loaded.

Load the document 

correctly.
-

Check if there is jammed 

paper.

Check the error message 

and remove the jammed 

paper.

-

Check if the telephone line 

is properly connected.

Connect the telephone line 

correctly. -

Check if the memory is 

enough.

Check the memory.
-

Check if the external 

telephone is connected.

If you hold the 

telephone and can hear a 

ring tone, this means the 

fax is coming in.

 After listening to a beep 

(two seconds later), hang 

up the telephone to receive 

the fax.
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 Image Quality Problem 

If you can solve problems with below steps, contact the authorized dealer.      
     

Problem Cause Solution

Cannot print anything. Check if the document is 

loaded with its correct side 

facing the right direction.

Load the document with its 

correct side facing the right 

direction.

Several pages are fed at the 

same time.

Shake the document so that 

pages are not attached to 

each other.  

The toner is low. Change the toner cartridge. 

The device has a problem. Contact the authorized 

dealer.

Black dots are printed. Paper is wet. Change the new paper.  

Improper paper is used. Use proper paper.  

The flatbed is dirty. Clean up the flatbed.  

Paper becomes wrinkled or 

texts are not clear.

Improper paper is used. Use proper paper.  

Paper is wet. Change the new paper.

Black dots are printed in the 

feeding direction.

The flatbed is dirty. Clean up the flatbed. 

Overall output is dirty. The flatbed is dirty. 

The opposite side of the 

document is printed.

Clean up the flatbed. If the 

original document is thin, 

increase [Brightness] and 

[Background Remove]

 settings.  
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Problem Cause Solution

Output print is blur and un-

clear.

Paper is wet. Change the new paper.

Check if the document is 

yellow or green.

Send the black document. 

Copying is recommended.  

Improper paper is used. Use proper paper described 

in this manual.  

The contrast setting is wrong. Set the correct contrast 

setting.  

White or black spots are 

printed.

Improper paper is used. Use proper paper.  

The flatbed or pad is dirty. Clean up the flatbed or pad.

Regular stains or lines are 

printed.

The paper path is dirty. Test copy several times.

Black lines or stains are 

printed.

Paper is wet. Change the new paper.  

Improper paper is used. Use proper paper.  

The flatbed or pad is dirty. Clean up the flatbed or pad.

The device has a problem. Contact the authorized 

dealer.

The overall output is dark. The device has a problem. Contact the authorized 

dealer.

The edge is dirty. The platen pad is dirty. Use the same size paper as 

the original document.  

Paper is bigger than the 

original document. (Zoom: 

100%)

Clean up the platen pad.  

Paper orientation is different 

from document orientation.

Select the paper with the 

same orientation or match 

orientations between 

document and paper. 

The output is not reduced to 

paper.

Select the correct scale that 

fits into paper.  
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Problem Cause Solution

Slanted image The document is not correctly 

loaded.

Load the document cor-

rectly. 

The document is not suitable for 

the ADF.

Use the document suitable 

for the ADF.  

Check if a foreign material is on 

the flatbed.

Clean up the flatbed.  

Paper is not correctly loaded. Load paper correctly.  

Black spots are printed on 

the last part of paper.

The size is different from the 

document.

Set the size to the 

document. 

Shadow image when 

scanning the OHP

The film is not fully pressed. Place a book on the film for 

tight pressing.  

 Network Problem

Problem Cause Solution

No Connec-

tion between 

Device and 

Network (No 

Network 

Scan/Print)

Problem 

in network 

connection or 

setting

 For the wire network, check if the network line is properly    

   connected. (Both of LED lamps of the device ports should 

   be on or blink if the line is correctly connected.)

 For the wireless network, check if the wireless network 

   adapter is properly installed. (The LED of the wireless 

   network adapter should be on or blink.)

 To use network scan/printer functions, the PC and device 

   should have the same (sub) netmask and gateway.

 If connection is correct, see 4.7 Network Settings to check   

   networks settings.

 If the problem continues, contact the network administrator.

Cannot Send 

the Scanned 

File by 

E-mail/FTP.

 Problem   

  in network  

  connection.

 Problem in   

  e-mail/FTP  

  settings

 Check if network connection is correct.

 Check e-mail server (SMTP) settings (server address, 

   authentication, ID/password).

 Check if the receiver’s e-mail/FTP server address is

   correct.

 Contact your service provider to see if the e-mail server    

   supports external access.
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9. Power Shutdown                    

If the device has a problem, see below instructions. If you can resolve the problem with following 

instructions, contact one of our dealers. 

Power Shutdown             

During a call Cannot make a call.  

During transmission Transmission is not available.

During receipt Receipt is not available.  

Fax while copying

List print while 

printing

Copy and print are not available.  

Operation While Power Is Off                    

Copy Not available

Fax transmission Not available

Fax receipt Not available

Memory Backup 

Fax transmission Scanned images are stored and maintained in the memory. 

Fax receipt Received images are stored and maintained in the memory.  

Address book The address book is stored and maintained in the memory.  
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10. Basic Printer Troubleshooting 

Sometimes device problems can be easily resolved. Try below instructions when a problem occurs. 

1 See 「Lamps」 (P.1-8) if the red lamp blinks.

2 Check if the power cord is correctly connected to the device and wall outlet. .

3 Turn on the device.

4 Check if the device is on or power switch is damaged.

5 Check if other equipment connected to the same wall outlet is working.

6 Check if all parts are properly installed. 

7  If the problem persists even after above instructions are followed. Turn off the device, wait 10 

seconds, and then turn on the device again

  Control Panel Troubleshooting

   Trouble 1: LCD displays nothing.

    Troubleshooting :  Turn off the device, wait 10 seconds, and then turn on the device again. 

             If the message is not displayed, turn off the device and contact the dealer. 

  Device Troubleshooting

   Trouble 1: Slow in printing paper with a width of less than 182 mm. 

    Troubleshooting : Narrow paper slows printing speed. 

              For faster printing speed, use 182 mm or wider paper. 

 Trouble 2 : The device cannot print at all or black stain is printed on the   

                     right side of paper. 

    Troubleshooting :  Check if the cartridge is properly installed. Open the 

front cover and reset the cartridge. 
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   Trouble 3: The device cannot print. 

    Troubleshooting :  1) Check if Ready is displayed on the LCD. 

   2) Check if paper is fed. 

   3) Check if the device language and driver are properly selected

   4) Check if the USB cable is properly connected. 

   5) Check if the correct paper size is selected in the printer setting or 

       device driver

   6) Check if data is sent from the device status window. 

  Note

        - Device status checking methods may vary by OS. 

    For more information, see the OS manual or help. 

   Trouble 4: The USB memory is connected but the device cannot print.

    Troubleshooting : Check if your OS supports the USB memory.

   Trouble 5: There is a problem in paper feeding or several sheets of paper are fed at once. 

    Troubleshooting : 1) Check if proper paper is used. 

     2) Reload paper by changing its side or orientation and check if printing   

         quality is improved.

     3) Adjust paper with guides

   Trouble 6: Paper from the different tray is used. 

    Troubleshooting : Check paper setting in the printer setting or printer driver

   Trouble 7: Output page is not correctly stacked. 

    Troubleshooting : Reload paper by changing its side or orientation.

   Trouble 8: Parts are lost or damaged. 

    Troubleshooting : Contact our dealer. 
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   Trouble 9: The device is on but the lamp in the control panel is not on. 

    Troubleshooting : The lamp can be on several seconds later. 

              Check if the power cord is properly connected.

   Trouble 10: The front cover is not closed.

      Troubleshooting : Check if the cartridge is properly installed.

   Trouble 11: The device is on but it cannot print anything. 

      Troubleshooting : Check if the cartridge is installed or if the USB cable is properly connected

   Trouble 12: Paper is not fed from the tray 1

      Troubleshooting :  1) Blow the air into paper and then reload it to the tray 1. 

      2) Select the tray 1 from the device driver or control panel. 

      3) Do not overload the tray. 

      4) Adjust paper so that it fits into the tray. 

   Trouble 13: Paper is not fed from the tray 2.

      Troubleshooting : 1) Select the tray 2 from the device driver or control panel. 

      2) Push the tray 2. 

      3) Press the metal place in the tray 2, and then push the tray 2. 

         (When the tray 2 enters the device, the metal plate goes up.) 

      4) Do not overload the tray 2. 

      5) Adjust paper so that it fits into the tray. 

      6) Blow the air into paper and then reload it to the tray 2. 

   Trouble 14: After jammed paper is removed, the control panel still displays “Paper Jam”.

      Troubleshooting : 1) Remove paper from the paper path. 

      2) Press the 【Continue】 button or open and close the front cover to restart  

          the device. 

      3) Insert the cartridge. 

.
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  Trouble 15 : Cannot connect the network.

      Troubleshooting : Check the cable.

     - For the wire network

        Check if the LED lamp blinks.

        If not, the network is not properly connected.

                                       To check if the network cable has a problem, connect the network able to   

                                       the PC or other device.

                                   -  For the wireless network

        Check if the LED of the wireless adapter is on.

Troubleshooting

If the LED of the wireless adapter is on, Check the wireless AP’s SSID and password 

(if necessary), and then retry.

If the wireless AP is not found, it has a problem or reception is week. Use other network device   

(PC, smart phone) to see if the AP is found and reception is appropriate.

If the reception level is low, put the wireless AP closer to the device.

  Device Quality Troubleshooting 

Replace consumables to improve device quality or maintain parts which reached end of its life. 

See below instructions for device quality troubleshooting. 

If you cannot solve the problem, contact our dealer.

 Trouble 1: Text is blurred. 

    Troubleshooting :  1) The toner may be low. Replace the toner cartridge. 

            2) The drum cartridge may have a problem. 

                Replace the new drum cartridge. 

            3) Set toner density to 8 or higher from the printer   

                setting or driver. 

               4) Select correct settings for OHP, card stock or label  

                paper from the device driver. 

            5) Check if paper is wet. 

                  6) Do not use rough paper.
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 Trouble 2: Toner stains are on paper. 

    Troubleshooting : 1) Check if paper is properly fed. 

           2) The drum cartridge may have a problem. 

               Replace the new drum cartridge. 

           3) The toner is on the roller. Clean up the roller. 

              To prevent this problem, do not use paper smaller   

                                      than the image to be printed. 

           4) Set the correct paper size from the printer setting  

              or driver. 

           5) Open and close the front cover. 

               The roller is automatically cleaned.

 Trouble 3: The toner is smeared on paper. 

    Troubleshooting :  1) Set paper weight to heavy and choose rough 

               texture from the print setting. 

           2) Check paper from device specifications. 

           3) Check if correct paper is set from the printer 

               setting or driver. 

            4) Use different paper. Printer paper provides the            

                                      best quality. 

           5) The toner cartridge may have a problem. 

               Replace the new toner cartridge.

 Trouble 4: Vertical or horizontal line.

    Troubleshooting :  1) The toner may be low. Shake the cartridge to use  

               the remaining toner.

           2) The toner cartridge may have a problem. 

               Replace the new toner cartridge.

 

  Trouble 5: When pie charts or bar graphs are printed, vertical lines with various widths are  

 printed. 

      Troubleshooting : 1) Contaminants such as paper powder or nap are on the head lens. 

          Clean up the head lens.

                      2) The toner cartridge may have a problem. Replace the new toner 

          cartridge.

      3) The drum cartridge may have a problem. Replace the new drum 

          cartridge.
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                                                        Trouble 6: While or black lines are printed on the OHP or       

                                                        paper.

         Troubleshooting :    1) The toner may be low.         

                                        Shake the cartridge to use     

                                         the remaining toner. 

       2) The toner cartridge may                                            

                                        have a problem. Replace                                           

                                        the toner cartridge. 

                                    3) The drum cartridge may  

                                        have a problem. Replace               

                                        the drum cartridge.

 Trouble 7: Pale images or repeated spots are printed.

    Troubleshooting : 1) The toner cartridge may have a problem. Replace   

                         the new toner cartridge. 

                                 2) The drum cartridge may have a problem. 

              Replace the new drum cartridge.

 Trouble 8: The text outline is not clear and image quality is low.

    Troubleshooting :  Change resolution from the device driver.  

 Trouble 9: Printing function is OK, but wrong top and side margins..

    Troubleshooting :  1) Check if the correct size is set from the print   

                          setting or device driver. 

           2) Check if the correct margin is set from the 

               application. 
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 Trouble 10: Too thick print.

      Troubleshooting :  1) Set correct toner density from the print setting or  

      driver. 

             2) Check if paper is wet. 

             3) Do not use rough paper. 

                                    4) Check if the media type in the print setting     

                                        matches the paper in the tray. 

                                    5) Check if the paper type in the control panel     

                                        matches paper in the tray. 

                                    6) The toner cartridge may have a problem. 

                                        Replace the toner cartridge. 

 

                                     Trouble 11: The device outputs blank paper.

      Troubleshooting :  1) The toner is low. Replace the new toner cartridge.  

             2) Software may have a problem. 

      Switch off and on the device. 

             3) Check if the cartridge is unpacked. 

             4) Check if the cartridge is installed correctly. 

             5) If the problem persists after above steps are 

      taken, contact the customer support.

 

 Trouble 12: All or part of paper is printed in black. 

      Troubleshooting :   Check if the cartridge is installed properly. 

             Open the front cover and reset the cartridge.

 



5-51

Maintenance and Troubleshooting

5

 Trouble 13: Toner stain or shadow in the background.

      Troubleshooting :  1) Check if the cartridge is properly installed. 

              2) The toner cartridge may have a problem. 

       Replace the new toner cartridge.  

              3) The drum cartridge may have a problem. 

       Replace the new drum cartridge.

              4) The toner exists in the paper path, 

       Contact the customer support. 

   Trouble 14: Thick or rough paper drops print quality.

      Troubleshooting :  See 「Paper Setting Table」 (P. 4-3). Set Paper Texture and Paper Weight   

      to Rough and Heavy respectively. 

  Tray 2 Troubleshooting 

     Trouble 1: The device does not work or stop in the middle of operation after the tray 2 is   

 installed.

    Troubleshooting :  A. Switch off the device, wait 10 seconds, and then switch on the device. 

        If the problem continues, check if the tray 2 is properly connected to the 

        device. 

        B. Check if the tray 2 is set in the device driver.
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11. When the Problem Is Not Resolved                                    

If you cannot resolve the problem with instructions in this manual, contact one of our dealers. 

  Other Troubleshooting

   Trouble 1: How can I get the printer driver or utility updates? 

    Troubleshooting :  Visit our website (www.sindoh.com) and download them. 

   Trouble 2: The scanner driver is not visible from Window 2008 Server

    Troubleshooting : Go to “Server Administrator  Function  Add Function  Desktop   

              Experience”.

  Customer Support  

Explain the problem, message on the LCD and steps taken to solve the problem. Also, you should 

be aware of the model and serial number.  

 Caution

        -    If you sense unusual sound, smell or smoke from the device, unplug the power cord i  

 mmediately and contact one of our dealers. Do not disassemble or repair the device by   

 yourself.

        -   The problem caused by unauthorized repair, remodel or consumables may not be covered  

   by the warranty.
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1. Specifications             

  Main Body Specifications                        

Item Specification

Type Desktop

Container Material OPC

Print Type Dry Static Shooting

Expose Type 1D Projection with the Laser Beam 

Development Type Drum-Development Roller Contact

Fusion Type Heat Pressure Roller

Scan Type CIS

Paper Paper Cassette: 

A4, A5, JIS B5, Folio, Letter, Legal, Executive, Statement 

Manual Tray: 

A4, A5, JIS B5, Folio, Letter, Legal, Executive, 

Statement, Irregular (Length: 127~356mm, Width: 

76~216mm)  

Max. Capacity 

Paper Cassette: 250 Sheets (75g/m2) 

Manual Tray: 50 Sheets(75g/m2) 

Memory Capacity Standard 256MB  

Power 110~127V, 50/60Hz(NA)

Power Consumption Power Save Mode: 6w or lower

Ready Mode: 85W or lower

Average: 540W or lower

Weight 31.4lb(IC included) 

Dimensions 16.3” x 14.8” x 13.9”  

Environment Condition Temperature: 10~32 °C (at 68% of humidity) 

Humidity: 20 ~ 80% RH (at 30 °C)  
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  Copy Specifications   

Item Specification

Scan/Print Line Density Scan: 600dpi×600dpi 

Print: enhanced 1200

Preparation Time 35 seconds or less (Ambient temperature: 20°C)  

First Copy Time 9seconds (A4 Landscape, Flatbed, Tray 1)  

Continuous Copy Rate 32 copies/min. (M402)

36 copies/min. (M403)

No. of Copies 1~99

      

  Fax Specifications 

Item Specification

Scan Line Density Standard: 200dpi×100dpi 

Fine: 200dpi×200dpi 

Super Fine: 300dpi×300dpi 

Baud Rate 33600, 31200, 28800, 26400, 24000, 21600, 19200, 

16800, 14400, 12000, 9600, 7200, 4800, 2400bps

(Automatic Switching) 

Telephone Line PSTN

Transmission Time G3 Real Transmission Time: 3±1 seconds  

Encoding MH/MR/MMR/JBIG  

ECM Supported

                                               
   Scanner Specifications  

Item Specification

Scanner Driver TWAIN

Scan Color Black & White/Grey/Color

Half Tone 256 Levels

Resolution 600dpi, 300dpi, 200dpi,150dpi, 100dpi, 75dpi  

Scan Size DLT (Flatbed Scan), Letter, Legal (ADF), Folio (ADF), 

Executive, A4, A5, B5  
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Item Specification

Interface USB 2.0 port, 1 Ethernet, Wi-Fi(Option)

OS  USB: Windows XP, Windows Server 2003, Windows 

Vista, Windows Server 2008, Windows 7  

Scan Rate 25 sheets/min (300dpi, ADF)  

Transmission File Format Lossless JPEG  

 

  Printer Specifications   

Item Specification

Print Rate 32ppm(M402)

36ppm(M403)

Resolution Enhanced 1200

Color Black & White

Interface USB 2.0, 1 Ethernet, 1 Wi-Fi(Option)

Printer Language PCL5e/6, PS3, SDHAPL

Compatible OS Windows XP, Windows Server 2003, Windows Vista, 

Windows Server 2008, Windows 7

Paper Size Tray: A4, A5, JIS B5, Folio, Letter, Legal, Executive, 

Statement 

MPT: A4, A5, JIS B5, Folio, Letter, Legal, Executive, 

Statement, Irregular (Length: 127~356mm, Width: 

76~216mm)  

  ADF   

Item Specification

ADF One-sided document

Document Size A5~Legal  

Capacity A4 or less: 35 sheets (75g/m2)  

Power Supplied from the main body

Dimensions 415 (W) × 315 (D)×60 (H) mm  

Weight About 1.7kg  
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  Tray 2 (Option)                                      

Item Specification

Paper Type Standard 60~90g/m2
)

Paper Size Paper Cassette: 

A4, A5, JIS B5, Folio, Letter, Legal, Executive, Statement 

Power Supplied from the main body

      



-   The warranty period is one year.
 

- Recommended use: 

     3,000 copies/month(M401) 

     5,000 copies/month(M402, M403)

- Use of Consumables

Category First Installation Sales Remark

Toner M401 (2,500 sheets)

2,500 sheets  

5,000 sheets  

8,000 sheets

A4 5% chart

Environments 

Temperature: 23±2℃, 

Humidity: 50±10%RH

(ISO/IEC 19752)

M402 (2,500 sheets)

M403 (2,500 sheets)

Drum 34,000 sheets (Continuous output)

      ※ When A4 5% (or document with many images) is processed, the life of toner and drum car     

          tridges are reduced.

      ※ Errors can happen according to operation environments.

      ※ Supply claims are judged based on our standard.

- Expendable Parts

Category Parts Capacity Remark

M401

M402

M403

Fusing part 100,000 sheets

Based on plain paperTray pickup roller 

and tray separation pad 

80,000 sheets

Multipurpose tray separation pad 30,000 sheets

Transfer roller 50,000 sheets ＊Based on the A4 5% chart

ADF separation pad 30,000 sheets

ADF pick up 150,000 sheets

      ※ Since above parts directly affect image and operation, replace them timely.

      ※ If a problem occurs within their life, it is handled according to our standard.

www.sindoh.com

Warranty Conditions (Product Name M400 Series)
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